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Concept and objectives of this PWLM Guidebook
This guidebook is intended to provide an overview of how to conduct climate change and land-use change impact as-
sessments, so that the impacts on water, biodiversity, and health can be better understood at the local level. A key aspect 
of the guidebook is the tutorials provided for conducting climate change/land-use change scenario analysis and impact 
assessment using free software. The methodology presented (PWLM) and training materials provided can help local gov-
ernments with their climate change adaptation and land-use planning, and is designed to complement/support countries’ 
official processes. Using these training materials as a basis, more intensive in-person (or online) trainings can also be 
conducted to provide more specialized or location-specific trainings in priority sites.
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This guidebook introduces several concepts and methodologies for evaluating and 
building resilience to climate change and land-use change at a “watershed” (i.e. 
river basin) scale. Specifically, it presents a framework that we developed, called 
“Participatory Watershed Land-use Management” (PWLM), which utilizes various 
participatory approaches and geospatial modeling techniques to quantitatively 
evaluate the potential impacts of climate change and land-use changes, and to de-
velop suitable countermeasures, at the watershed scale.

The target of the PWLM approach is to help the local governments located within a 
watershed work together to quantify climate change/ land-use change impacts and 
develop more resilient development plans, so that future generations can be pro-
tected from climate-related hazards and continue enjoying the benefits provided by 
nature. This guidebook is intended for technical experts (environmental scientists, 
hydrologists, GIS experts, etc.) and managers/policymakers working at the local  
level. 
Before continuing, we recommend you watch our YouTube video (https://youtu.be/
QZ6LCxgaZgg) to get a basic understanding of the PWLM approach.

Chapter 1: Introduction

Brian A. Johnson
Damasa B. Magcale-Macandog
Isao Endo

Overview

In this chapter, you will:

Learn how climate change and land-use change can affect communities’ resilience at a 
watershed scale. 

Be introduced to the steps involved in the Participatory Watershed Land-use Manage-
ment (PWLM) approach, which will be covered in detail in subsequent chapters.

YouTube video on PWLM
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Climate change and land-use change can have significant 
impacts on people’s exposure to climate-related hazards. 
In many parts of the world, extreme weather events like 
typhoons and droughts are expected to occur more and 
more frequently due to global climate change, while large-
scale conversion of forests and other natural habitats to 
urban and agricultural areas is also causing soil erosion 
and increased river flooding in many places.
Local disaster risks associated with climate change are 
typically thought of as being related to three factors: 

(1) The frequency and level of extremity of the climate-re-
lated hazards experienced in the locality; 
(2) The level of exposure to these climate-related hazards, 
e.g. the number of people and properties located in the 
impacted areas; and
(3) The level of vulnerability of the people/infrastructure/
environment in the areas exposed to the climate-related 
hazards 
Figure 1.1 shows how all three factors (i.e. hazards, ex-
posure, and vulnerability) interact to determine disaster 
risk. 

Aside from their impacts on disaster risk, climate change 
and land-use change can have a variety of other local im-
pacts. For example, loss/degradation of natural forests due 
to changing climate conditions or land-use conversion 
may result in the loss of biodiversity (due to loss of the 
habitat of the species living in the forest) and deteriora-
tion of water quality (because the forest areas help reduce 
runoff of contaminants into water bodies), among other 
things. To help visualize how these types of changes in 
climate and/or land-use can impact the environment and 
society, one interesting tool is called the “impact chain”
 (https://www.pik-potsdam.de/cigrasp-2/ic/ic.html). 
The impact chain is basically a graphical representation 
of how a specific climate or land-use modification

 (i.e. a “stimulus”) is likely to directly and indirectly affect 
a location of interest. The impact chain can be developed 
based on scientific models, local knowledge, or other rel-
evant information. One example of an impact chain is 
shown in Figure 1.2 to demonstrate the approach. From 
this example in Figure 1.2, we can see that climate change 
(increasing rainfall and extreme rainfall events), urban 
land expansion, and agricultural land expansion can have 
many interlinked direct and indirect impacts. Although 
the impact chain does not quantify the impacts identified, 
in cases where more than one stimulus is found to lead 
to the same impact, we can understand that this impact 
is likely significant, so efforts should be made to mitigate 
the problem. 

Figure 1.1. Concepts of hazard, exposure, vulnerability, and risk.

Main concepts

Hazards
・Extreme Climatic events;
・Changing weather patterns

Vulnerability
・Physical
・Social
・Financial
・EnvironmentalRisk

・Population
・Agriculture
・Infrastructure
・Property

Exposure
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Water-related impacts of climate change and land-use 
change, including increased flooding, water quality deg-
radation, and drought, are typically experienced at a “wa-
tershed” scale, i.e. a river basin or sub-basin scale (Watch 
Video 1.1. for a detailed explanation of what watersheds 
are). Changes to the land conditions and/or the climate 
in upstream areas of a watershed can have dramatic 
impacts on the population living in the lower elevation 
downstream areas (see Figure 1.3 for an example). On the 
other hand, local climate change and land-use plans are 
typically formulated at the city or town level rather than 
a watershed level. This can lead to a disconnect between 
the local plans and the actual climate change/land-use 

change hazards within a watershed. For example, a city 
located in the higher elevation upstream part of a wa-
tershed may not experience flooding or poor river water 
quality, but if they do not take it into account, their land-
use decisions – e.g. their decision to convert forested 
lands to impervious urban areas – may unwittingly lead 
to increased flooding (due to higher rainfall runoff (Figure 
1.1) or lower water quality (due to waste discharge from 
urban areas) in the downstream cities located within the 
same watershed. Thus, coordinated land-use planning 
efforts at a watershed level are essential for ensuring re-
silience to climate change and land-use change.

Why is a watershed scale important?

Figure 1.2. Impact chain considering three 
stimuli: increasing rainfall and extreme 
rainfall events due to climate change, ur-
ban land expansion, and agricultural land 
expansion.

YouTube video on PWLM Video 1.1. What is a watershed (https://youtu.be/QOrVotzBNto)? 
Source: Battle River Watershed.

Figure 1.3. How climate change and land-use change in the up-
stream area of a watershed can lead to negative impacts down-
stream. In this example, increased rainfall (due to climate change) 
and the conversion of forest to residential land-use leads to higher 
rainfall-runoff and more flooding downstream.
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To estimate how climate change and land-use change 
will affect a watershed, planners and policymakers first 
need to have an understanding of how the climate and 
the land-use are likely to change in the future (e.g. over 
the next 10, 20, or 50 years). Once future climate and land-
use scenarios are identified, they can serve as input data 
for different types of computer simulation models to es-
timate the impacts of these changes, e.g. on flood hazard, 
water quality, or biodiversity. The “Participatory Water-
shed Land-use Management” (PWLM) approach presented 
in this guidebook is intended to help with this process. 
The PWLM approach can help complement qualitative 
approaches like the impact chain (Figure 1.2) by helping 
to quantify the potential impacts of future climate change 
and/or land-use change.

In the PWLM approach, future climate and land-use sce-
narios are generated, the impacts of these changes are 
estimated using free software/computer models, local 
governments identify countermeasures to reduce these 
impacts, and finally the local governments adopt these 
countermeasures in local plans and policies to increase 
their resilience to climate change. If some of the identified 
countermeasures require external funding from national 
or international sources to implement (e.g. costly infra-
structure like artificial wetlands or stormwater retention 
ponds), they can be used as a basis to develop proposals 
for climate change adaptation funding from sources 
like the Green Climate Fund (https://www.greenclimate.
fund/). We hope that by using the PWLM approach, local 
governments and other stakeholders can better under-
stand the potential impacts of climate change and land-
use change at the watershed scale, so that more effective 
policies, plans, and infrastructure can be put in place. 

The PWLM approach utilizes a combination of participa-
tory processes and geospatial modeling techniques for 
this impact assessment and policy development, and con-
sists of four main steps:

Figure 1.2 provides an overview of these four steps, and 
the processes and software/tools required for each step. 
All of these processes are described in more detail in the 
subsequent chapters, and you will learn how to apply 
them yourselves through a series of hands-on tutorials. 

Scenario development: Future scenarios of land-use 
change and climate change are identified ;

Impact assessment: Impacts of the future land-use 
change/climate change scenario(s) are analyzed us-
ing different computer models and software;

Countermeasure identification: Local governments 
within the watershed identify countermeasures 
based on the risk assessments, and try to agree upon 
some priority countermeasures relevant at the water-
shed scale;

Climate resilient land-use planning and imple-
mentation: Local governments use the identified 
countermeasures to improve their land-use plans, and 
for development of climate change adaptation actions 
and policies. The identified countermeasures can also 
be used to develop project proposals for domestic or 
international sources of climate change adaptation 
funding (e.g. through the Green Climate Fund:
https://www.greenclimate.fund/).

1. 

2. 

3. 

4. 

Participatory Watershed Land-use Management (PWLM)
approach
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Scenario
Analysis

Step 1

Impact
Assessment

Step 2

Climate resilient
land-use

planning and
implementation

Step 4
Countermeasure
Identification

Step 3

・Stakeholder consultations.
・Participatory mapping of future   
   land-use.

・Downscaling climate model data

・Improving local plans and
   policies incorporating identified   
   countermeasures.

・Applying for climate adaptation 
   funding to implement 
   countermeasures.

・Stakeholder consultations.

・Participatory countermeasure 
   development.

・Flood impact assessment.

・Water quality impact assessment.

・Habitat quality impact
   assessment

Software used:

Software used:

Figure 1.2. Four steps of the PWLM approach, and the different processes and software/tools required in each step.

In the first step of PWLM, future scenarios of land-use change and climate change are developed through participatory 
mapping (for land-use scenarios) and downscaling of climate model projections (for climate change scenarios). 

Step 1: Scenario Development (covered in Chapters 2 and 3) 

To understand the likely future land-use changes of a 
watershed, a participatory mapping approach is used. 
For this, a stakeholder consultation workshop should 
be organized, wherein representatives from each local 
government within a watershed share their land-use 
and development plans. A map of the future land-use is 
created through a participatory mapping activity. Local 
government officials sketch their planned future land-
use conversions (e.g. based on their land-use plan, or their 
knowledge of planned land acquisitions/development) 

onto a printed map using markers and tracing paper (see 
Figure 1.3 for some examples). Each local government 
then presents its future land-use plans to the other local 
governments in the watershed, so that all have a better 
understanding of the future land-use conditions of the 
watershed. Later, the sketched maps are digitized and 
georeferenced using the free Geographic Information 
Systems (GIS) software “QGIS”. Chapter 2 of this guidebook 
provides a step-by-step tutorial on how to perform this 
land-use scenario development.   

Land-use scenario development

To understand the future climate changes of a watershed, 
projections from General Circulation Models (GCMs, a.k.a. 
Global Climate Models) or Regional Circulation Models 
(RCMs, a.k.a. Regional Climate Models) are used. GCMs/
RCMs are computer models of the future climate, assum-
ing different levels of future greenhouse gas emissions. 
The Intergovernmental Panel on Climate Change (IPCC) 
has estimated these future levels of emissions under 
different socioeconomic scenarios known as Relative 

Concentration Pathways (RCPs). Due to the high level of 
uncertainty of these future climate change estimates, 
multiple scenarios should be used to show a range of pos-
sible futures. For higher accuracy, the climate model data 
should also be downscaled and bias-corrected using local 
climate observations. Chapter 3 of this guidebook covers 
the basics of GCMs, how to acquire the GCM data, and how 
to visualize it in QGIS software.

Climate change scenario development
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Figure 1.3. Participatory future land-use mapping activity.

Main outputs of Step 1 Software used in Step 1

1. Current land-use map

QGIS: https://www.qgis.org/en/site/ 2. Future land-use map

3. Downscaled climate data
(current and future daily/monthly data)

Step 1: Scenario development (Participatory GIS)
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Step 2: Impact Assessment (Chapters 4, 5, and 6)

In the second step of PWLM, impact assessment, comput-
er modeling software is used to estimate various impacts 
of the future land-use and climate changes. For the PWLM 
approach to be open to as many as possible, in this guide-
book we have demonstrated how to conduct all of the im-
pact assessments using freely available GIS and modeling 
software. 

Chapter 4 of this guidebook shows you how to perform 
river water quality impact assessment using the Water 
Environment and Planning (WEAP) software, using data 
from a case study site in the Philippines. Chapter 5 shows 
you how to perform flood hazard impact assessment us-
ing three software packages: QGIS, HEC-HMS, and HEC-
RAS. Chapter 6 shows you how to perform habitat quality 
impact assessment using the InVEST software package. 

Main outputs of Step 2 Software used in Step 2

QGIS: https://www.qgis.org/en/site/
HEC-HMS: https://www.hec.usace.army.mil/software/hec-hms/
HEC-RAS: https://www.hec.usace.army.mil/software/hec-ras/
Water Evaluation and Planning (WEAP): https://www.weap21.org/
InVEST: https://naturalcapitalproject.stanford.edu/software/invest

Habitat quality maps
 (current and future)

Water quality parameters
 (current and future)

Flood hazard maps
 (current and future)

Main outputs of Step 3 Software used in Step 3

No specific software needed
List of countermeasures identified by each local government in the watershed
List of priority countermeasures for watershed as a whole

Step 3: Countermeasure Identification (Chapter 7)

In the third step of PWLM, countermeasures to reduce the 
negative impacts of future land-use changes and climate 
change are identified using a participatory process. For 
this, the results of the impact assessments from Step 2 
are presented to all of the local governments within the 
watershed, and the local government officials are asked to 
think of potential countermeasures and write them down 
(e.g. using markers and adhesive notecards, as shown in 
Figure 1.4). Each local government presents their identi-
fied countermeasures, and finally, some common/priority 
countermeasures are discussed and identified for the wa-
tershed as a whole. 

Figure 1.3. Stakeholder consultations to develop countermea-
sures for reducing the impacts of future land-use changes 
and climate change.
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Step 4: Climate resilient land-use planning and implementation (Chapter 7)

In the final step of PWLM, the priority countermeasures 
identified from Step 3 are used as a basis for developing 
more climate resilient land-use plans and other policies, 
as well as for implementing climate change adaptation 
actions and infrastructure. This is probably the most im-
portant step of PWLM, as the goal of this step is to trans-
late the scientific information generated through PWLM 
into concrete actions.
 
Some countermeasures identified through PWLM may 
be possible for local governments to implement on their 
own (e.g. changing zoning regulations or building codes), 
while some measures may be too costly for the local 
governments to implement without external aid. In case 
external aid is necessary, the identified countermeasures 
can be proposed as projects for funding by the Green Cli-

mate Fund or other national/international climate adap-
tation funds. Examples of the types of adaptation projects 
funded by the Green Climate Fund can be found at https://
www.greenclimate.fund/projects?f[]=field_theme:235. The 
Green Climate Fund and other types of adaptation funds 
typically require a climate change impact assessment to 
be conducted prior to applying for project funding (to jus-
tify why the funds are needed, and to estimate the bene-
fits of the proposed project). The impact assessments from 
step 2 of PWLM provide the basis for this assessment. 

In Chapter 6 of this guidebook, we show some specific ex-
amples of the types of actions that could be taken in step 
4 of PWLM, based on the results of a case study conducted 
in the Philippines. 

Main outputs of Step 4 Software used in Step 4

No specific software needed

1. More climate resilient local policies and plans 

2. Project proposals for climate change adaptation-related funds
    (to help implement any identified countermeasures that require external funding)

References

Endo, I., Magcale-Macandog, D. B., Kojima, S., Johnson, B. A., Bragais, M. A., Macandog, P. B. M., & Scheyvens, H. (2017). Participa-
tory land-use approach for integrating climate change adaptation and mitigation into basin-scale local planning. Sustainable 
cities and society, 35, 47-56.

Kumar, P., Johnson, B. A., Dasgupta, R., Avtar, R., Chakraborty, S., Kawai, M., & Magcale-Macandog, D. B. (2020). Participatory ap-
proach for more robust water resource management: Case study of the Santa Rosa sub-watershed of the Philippines. Water, 12(4), 
1172.
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Chapter 2: Land-use scenario 
analysis

Brian A. Johnson

Land-use changes can have a significant impact on the biodiversity, water quality, 
and damage caused by extreme weather events in a watershed. This chapter gives 
an overview of the impacts of land-use changes, and demonstrates how to perform 
land-use change scenario analysis. In the chapter, you will learn how to create your 
own maps of the current and future land-use of a study site using free Geographic 
Information Systems (GIS) software. This represents the land-use change scenario 
development component of PWLM Step 1 (“Scenario Analysis”). These maps will 
serve as the basis for conducting land-use change impact assessments in PWLM 
Step 2 (“Impact Assessment”), which are explained in Chapters 4-5.

Overview of this chapter

After completing the chapter, you will be 
able to:

Perform basic GIS operations in QGIS software (https://qgis.org/en/site/);

Generate your own land-use maps showing the current and future (planned) land-use. 
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Main concepts

As introduced in Chapter 1, land-use is a major factor that 
affects a community’s resilience to climate change and 
climate-related hazards. Conserving and restoring forests, 
wetlands, and other natural ecosystems can reduce the 
cause of climate change (CO2 emissions) as well as the 
potential impacts like increased flooding and landslides 
(by minimizing surface runoff and soil erosion). In con-
trast, converting natural ecosystems or other highly-veg-
etated areas into urban or intensive agricultural areas can 
have the opposite effect, resulting in the release of CO2 
emissions from deforestation/forest degradation as well 
as increased climate-related hazards like floods and land-
slides (due to increased runoff and erosion). This influ-
ence of land-use on stormwater runoff can be clearly seen 
by looking at the rainfall-runoff coefficients (called ”curve 
numbers” (Soil Conservation Service, 1986)) of different 
land-use types, developed by the U.S. Soil Conservation 
Service (see Table 2.1.). 

Aside from flooding, land-use change can also have a 
major impact on the water quality and biodiversity of a 
watershed, among other things. As one example, when 
informal or formal settlements are constructed nearby a 
river bank (as in Figure 2.1.), there is often a deterioration 
of the river water quality due to the discharge of house-
hold wastes into the rivers. As another example, when a 
natural area near a river bank is converted to agricultural 
use, there is often increased soil erosion and pollution 
from fertilizers and pesticides. In both of these examples, 
the increased pollution from these land-use changes will 
negatively affect the river water quality (e.g. for drinking, 
bathing, or irrigation), and may also affect the animals 
and plants living in the river.

Figure 2.1. Informal settlement built along a river bank near Manila, Philippines.
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Of course, many other factors must be considered for land-
use planning, such as demand for urban, agricultural, and 
recreational land to meet the needs of growing popula-
tions and economies. In this chapter, we try to provide you 
with training in some of the tools/software that can help 
to better understand and manage the potential impacts 
of future land-use changes. The first step of this land-use 
change impact assessment process is to identify or cre-
ate the needed land-use maps; i.e. (i) a map of the current 
land-use, and (ii) a map of the planned (or potential) land-
use for a desired date in the future. The quality and quan-
tity of available land-use data vary significantly from one 
location to another, so identifying the appropriate land-
use map(s) is not always a simple process. If an accurate 
and up-to-date local land-use map is already available for 
your city/town (e.g. a land-use map produced by/regularly 

updated by your local government), this will probably be 
the best data to use for an impact assessment. If a local 
land-use map is not available, you can check online for 
other existing global-, regional-, or national-level land-
use maps to determine if they meet the level of detail (e.g. 
high enough spatial resolution, and a sufficient number of 
land-use classes mapped) and accuracy that you require. 
Finally, in case you need a more accurate/up-to-date/
detailed land-use map than what is available, you can 
always create your own by carefully digitizing land-use 
polygons over a satellite image base map using GIS soft-
ware. This digitizing process will be explained later in the 
chapter. A similar decision process can be used to identi-
fy the appropriate source of future land-use data (Figure 
3.1.2).

Land-use / land-cover

"Curve Number" (i.e. rainfall-
runoff coefficient) for hydrologic

soil groups A-D

Impervious areas Paved parking lots, roofs, driveways, etc.

A B C D

Open spaces
(parks, golf courses, cemeteries, etc.) 

Row crops

Fallow

Woods/grass combination
(Orchard or tree farm)

Impervious areas

Poor condition (grass cover < 50%)

Fair condition  (grass cover 50 to 75%)

Good condition (grass cover > 75%) 

Straight row (SR)

Contoured (C)

Bare soil

Crop residue cover (CR)

Poor

Fair

Good

Poor

Fair

Good

98 98 98 98

68 79 86 89

49 69 79 84

39 61 74 80

67 78 85 89

65 75 85 86

77 86 91 94

74 83 88 90

57 73 82 86

43 65 76 82

32 58 72 79

45 66 77 83

36 60 73 79

30 55 70 77

Curve Number value 0-50 50-70 70-90 90+

Table 2.1. Soil conservation service runoff Curve Numbers (CNs) of different land-use types, taking into account the soil type 
(hydrologic soil groups). Higher CN values indicate more rainfall runoff. Adapted from (Soil Conservation Service, 1986).

Use this data Use this data

Land-use map
( current condition )

yes no yes no

Use this data

yes no

Land-use map
( future condition )

Local Land-use map with 
acceptable level of accuracy

available?

Coarser (national, regional, or global) 
land-use map with acceptable level of 

accuracy available?

Use a participatory (GIS) mapping 
approach or a land-use simulation 
model to estimate the future land-

use conditions

Land-use map available (e.g.from 
land-use/zoning plans) at the 

desired time period in the future?

Digitize a new land-use map using a 
satellite image as a base map.

Figure 2.2. Process for identifying sources of current and future land-use data to use for impact assessments.
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This tutorial focuses on the process for preparing current and future land-use maps of a case study site, using free GIS 
software. We have provided all of the data for this tutorial in the folder entitled “QGIS_training”.

Tutorial

Step 1. Downloading and running QGIS
Much of the tutorial in this chapter is focused on QGIS, a free Geographic Information Systems (GIS) software package that 
is used commonly around the world. QGIS has a relatively simple user interface, and runs on Windows, Mac, Linux, and 
Android operating systems. You can downloaded the latest version of the software from https://www.qgis.org/en/site/. For 
the sake of this tutorial, we have already downloaded QGIS and provided it to you with this training package, so you can 
skip this downloading step.

To install QGIS on your computer, double-click the “osgeo4w-setup-x86_64.exe” file and follow the installation in-
structions. For this tutorial, we are using the version of QGIS for Windows operating systems.

Open QGIS Desktop using the Windows Start menu. 
After QGIS opens, you will see a browser menu on 
the left, and recent projects in the main window.

a

b

You will see two watersheds, the San Cristobal 
watershed and the San Juan watershed. Check the 
details of the added files by clicking on the “Iden-
tify features” icon in QGIS. You can also check by 
right-clicking on “NewWatersheds” in the Layers 
menu, and selecting “Open attribute table”. The 
“NAME” row shows the name of the watershed that 
the polygon contains, and the other rows show the 
size, area, and average population density of the 
watershed.

a

Step 3. Inspecting the data and modifying the layer style

To install QGIS on your computer, double-click the 
“osgeo4w-setup-x86_64.exe” file and follow the 
installation instructions. For this tutorial, we are 
using the version of QGIS for Windows operating 
systems.

a

Step 2. Loading GIS data of the boundary of a sample study site.
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Step 5. Create a future land-use map based on the outputs of a participatory mapping activity.

In Step 4, we loaded a GIS shapefile containing the cur-
rent land-use. For land-use change impact assessments, 
however, we also need a map showing the potential future 
land-use. This could be a land-use map based on your mu-
nicipality’s land-use or zoning plan, which may already 
be in GIS format. If no future land-use/zoning map exists 
already, a common approach to understand the potential 
future land-use conditions of a watershed is to conduct 
a participatory land-use mapping activity with relevant 
local government staff (i.e. those involved in land-use 

planning processes) as well as any other relevant stake-
holders. This kind of activity typically involves printing 
out a large poster-size map of the watershed, showing the 
watershed boundary, the administrative boundaries, the 
current land-use, the major roads and rivers, and other 
important geographic features. The local government 
staff then sketch the planned (or likely) future land-use 
changes using colored markers. To translate this analog 
data to digital GIS format, we can finally digitize it using 
GIS software. 

Drag the data from the “current_LU” folder using 
Windows file explorer or the Browser window in 
QGIS

a

Practice zooming in and out to the study area bound-
ary using the magnifier and “pan” icons above the 
map wi ndow.                                                                                 Practice turning on/off the 
two map layers by checking on/off the check boxes in 
the Layers window, and re-ordering the maps by drag-
ging them up and down in the Layers window. Finally, 
practice changing the colors of each land-use class by 
clicking the color box next to it in the “Symbol” column 
of the “Layer styling” window.

c

For easier visualization, you will assign a unique 
color to the polygons representing each land-use 
class. To do this, click on the “NAMRIA2015_LC” 
map layer in the Layers window to highlight this 
layer, and then click the Layer Styling Panel icon  
. In the Layer Styling window, change the symbol 
type from “Single Symbol” to “Categorized”, and 
specify the “AGC12” column as the column con-
taining the land-use information. Finally, click the 
“Classify” icon. 

b

Step 4. Adding a current land-use map (“NAMRIA2015_LC.shp”) and visualizing each land-use class as 
a different color.

a

b
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5.1. Creating a current land-use map to use as a basis for participatory mapping activity
Let’s create a very basic current land-use map that could be printed out and used for a participatory mapping activity.

Click on the “Project” menu, then click “Layout Manager…” from the dropdown box. A Layout Manager window will 
appear. Under New from Template header in this window, make sure “Empty layout” is selected and click the “Cre-
ate…” button. In the “Creat print layout Title” window that appears, please enter “San Cristobal” as the title, and then 
click “OK”. 

a

A new window entitled “San Cristobal” will appear. [If you close this window, you can open it again by clicking again 
on the “Project” menu, and then clicking “Layouts”, and “San Cristobal”.] In the next steps, you will create the current 
land-use map layout for San Cristobal watershed using the tools in this window.

b

To add a map to the layout, click on the “Add Item” menu, and click “Add Map” in the dropdown box. A crosshairs will 
appear for your mouse pointer, and you can click and drag a rectangle that will display the GIS layers in this layout. 
You can move the map or resize it by dragging or stretching the rectangle.

c
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Now you have completed the process of creating an existing land-use map of a watershed, which can be printed out and 
used to conduct a participatory mapping activity! The actual participatory mapping can be done by providing markers of 
different colors to the participants, and asking them to draw out their planned future land-use changes in different colors. 
For example, they might digitize new planned urban developments in red, new parks or other green spaces in green, and 
new agricultural areas in yellow. Once this is completed, this analog data will need to be digitized into a new GIS layer. 

Zoom into your area of interest in the map (e.g. the two watersheds). If you forgot how to zoom in, refer to step 4 (c)g

Save the layout by clicking the “Layout” menu, and clicking “Save project”. You can also click the disk icon below the 
Layout menu to save.

h

Finally, save the layout as a .pdf file by clicking the “Layout” menu, and clicking “Export to pdf” in the dropdown box. 
Name the file “San Cristobal watershed” and save it in the “QGIS_outputs” folder. 

i

Add a map legend by clicking on the “Add item” menu and clicking “Add legend” in the dropdown box. You can draw 
a rectangle to indicate where you want the legend to go. Usually, map legends go in one of the corners of the map lay-
out, where they will not obstruct the GIS layers shown in the map.

d

Add a scale bar to the map by clicking on the “Add item” menu and clicking “Add Scale Bar” in the dropdown box. You 
can draw a rectangle to indicate where you want the scale bar to go. Usually, scale bars also go in one of the corners 
of the map layout, where they will not obstruct the GIS layers shown in the map. Your layout window will look some-
thing like this after adding the Legend and scale bar:

e

Add a title for the map. Click again on the “Add item” menu, and click “Add label” in the dropdown box. Drag a rect-
angle in the top part of the layout window where the title will go. By default, the title text is “Lorem ipssum”. Let’s 
change this title by right-clicking on “Lorem ipsum”, and clicking “Item properties” from the dropdown box, and then 
entering a new title: “San Cristobal: Current Land-use”. You can make the text larger by clicking on the “Font” menu, 
and selecting a larger font size (try size 36 font).

f
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Step 5.2. Digitizing the future land-use map created through a participatory mapping activity.
In the next steps, we will practice the digitizing process in QGIS so that you can digitize a future (or current) land-use 
map using GIS software.

Open the Layer menu, click “Create Layer”, then click “New Shapefile Layer”.a

Set the file and file path by clicking the […] icon. Please name the file “Future_LU.shp”, and place it in the “QGIS_
training” folder.

b

Change the geometry type from “Point” to “Polygon”.c

For additional dimensions, specify “None”. d

Set the coordinate system and map projection to match the other GIS datasets (WGS 1984, UTM Zone 51N). e

For now, this is just an empty shapefile. As the next step, we need to digitize polygons 
representing the future land-use of the watershed.

Add a New Field to the file, called “AGC12”. This field will contain the future land-use class information of each poly-
gon that you will digitize. Set the Type to Text data, and the Length to 50. Click the “Add to Fields List” icon.

f

Make sure everything matches the screenshot below. Then click “OK”g
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Click the “Enable Snapping” icon  . Choose “Vertex and Segment”. This will ensure that polygons you digitize 
will snap to the existing polygons, and help avoid topological errors like overlapping polygons or gaps between 
polygons.

k

Turn on “Snapping” to that the digitized polygons snap to one another, to allow for easier mapping. Click the 
“Project” menu, then “Snapping Options”.

j

h Highlight the “Future_LU” layer in the Layers window, and click the Toggle Editing icon

Try digitizing a new polygon representing the “Built-up” land-use class. Click the Add Polygon Feature icon  
Left click in the map display at a location where you’d like to start digitizing a polygon feature, then keep left 
clicking to add vertices (corners) of the polygon. When you’ve got the shape you want, right click to close the 
polygon. For this exercise, just try adding 5-6 vertices for the polygon, like the example shown below. (If you 
aren’t happy with the polygon you made, and want to redo it, click the Undo icon  ). Add a unique ID number (1) 
and a land-use class (Built-up).

i
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Congratulations, you’ve learned the basics of displaying and digitizing land-use data in QGIS!
For a longer and more general QGIS tutorial, please also check the QGIS website: https://docs.qgis.org/3.4/en/docs/
training_manual/create_vector_data/create_new_vector.html. 
In the next steps, we will practice the digitizing process in QGIS so that you can digitize a future (or current) land-use 
map using GIS software.

Digitize another polygon with 5 vertices, this time of an “Annual Crop” land-use feature. Digitize it adjacent to 
the “Built-up” polygon you digitized earlier to practice snapping, and assign it an ID of 2. 

l

Try digitizing a few more polygons of the other types of land-use features. Assign a different color to each land-
use class in this new layer. Go back to Step 4(b) if you need to refresh your memory of how to do this.

m

Finally, save your edits by clicking on the “Save Layer Edits” icon!!!! n
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Chapter 3: Climate change sce-
nario analysis

Pankaj Kumar
Brian A. Johnson

Due to increasing greenhouse gas (GHG) concentrations in the atmosphere, the 
Earth’s climate is changing at the global scale. The main change is increased global 
temperatures, while the magnitude of the temperature changes varies from loca-
tion to location. Climate change is affecting the water cycle as well, leading to more 
rainfall in some regions and less in others, and changing the seasonal rainfall pat-
terns in many places (causing more/less drought or flooding, depending on the geo-
graphic region). To better understand local climate changes, projections from global 
climate models (i.e. general circulation models; GCMs) or regional climate models 
(RCMs) are typically downscaled using statistical approaches, and then bias-cor-
rected using local climate observation data. These downscaled and bias-corrected 
climate projections can be extremely useful for estimating the local impacts of cli-
mate change and identifying appropriate adaptation actions.

Overview of this chapter

This chapter will introduce you to GCMs and downscaling, and show you how to ac-
cess downscaled climate data. 

After completing the chapter, you will be 
able to:

Understand what GCMs are and how they are generated;

Download GCM data (future precipitation and temperature climate variables); and 

Visualize the climate change projection using QGIS software. 
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Main concepts

Climate change and its impacts

Climate change is caused by a variety of natural and 
anthropogenic factors. Some natural factors affecting 
climate include variations in solar radiation and the 
occurrence of volcanic eruptions. Human activities like 
burning of fossil fuels and deforestation, however, are 
believed to be the main drivers of climate change (due to 
increased concentrations of greenhouse gasses (GHGs) in 
the atmosphere). 

Global climate change is disrupting the ways that people 
live and interact with their environment. Some of the im-
pacts of climate change include the alteration of natural 
ecosystems, interruption of food production and water 
supply, damage to infrastructure, and human morbidity 
and mortality (e.g. from increased heat stroke, drought, or 
climate-induced disasters) (IPCC, 2014). The consequences 
of climate change are already becoming evident in terms 
of the changes in the amount, intensity and frequency of 
precipitation, and temperature in many parts of the world. 

The hydrosphere is possibly the most negatively affected 
component of the Earth system. Considering freshwater 
as a finite resource, many scientific studies have focused 
on evaluating the effects of climate change on precipita-
tion patterns and hydrologic regimes (Dore 2005, Kleinn et 
al. 2005, Abbs et al. 2007). These studies and other similar 
ones have highlighted the impacts of climate change on 
regional precipitation trends, which include increased 
flooding and drought as well as deteriorating water qual-
ity in many regions. Developing nations, many of which 
have inadequate infrastructure and/or water governance 
systems, are likely to be most significantly affected. Asia, 
having the highest gap between freshwater supply and 
demand, is expected to bear the brunt of these global 
changes. 
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Climate change projections

It is difficult to precisely predict the future climate at a 
specific location (e.g. city or town) due to uncertainties 
from climate models and various other sources. Under-
standing of the general trend of climate change and vari-
ability, however, is important for impact assessment and 
climate change adaptation. Climate projections are the 
main tools used to understand the expected impacts of 
climate change on different sectors of a country. Climate 
projections consist of a synthetic time-series of climate 
variables, such as daily or monthly precipitation and 

temperature. These climate projections are derived from 
general circulation models (GCMs), also called global cli-
mate models. A GCM is a mathematical model of the gen-
eral circulation of the planet’s atmosphere or oceans, and 
is based on mathematical equations that represent the 
physical processes described in figure 3.1. GCMs simulate 
the responses of changes in greenhouse gas concentra-
tions, and provide estimates of climate variables in the 
future (Mishra and Herath, 2011).

The GCM outputs are based on coarse resolution infor-
mation (e.g. orography and elevation) for the generation 
of climatic variables, and are typically of a coarse spatial 
resolution (hundreds of km pixel size). However, forcing 
and circulation that affect local climate generally occur 
at much finer scale than that of GCM. Therefore, direct use 
of GCM outputs is not suitable for local climate change 
impact assessments, and hence spatial downscaling is 
required. Spatial downscaling is the process of deriving 
finer resolution (i.e. local) of climate data from the coarse 
GCM output for the climate change impact studies at local 
level. There are various downscaling techniques to con-
vert the GCM outputs into locally applicable climate data. 
Although we will not discuss them in detail here, more 
information on downscaling methods can be found in 
Mishra and Herath (2011). 

GCMs (and the downscaled data from them) are generat-
ed based on estimated future greenhouse gas emissions, 
which are calculated for different socioeconomic sce-
narios. The most widely-used of these socioeconomic 
scenarios are the so-called “representative concentration 
pathways” (RCPs), including RCP 2.6, RCP 4.5, RCP 6.0, and 
RCP 8.5 (Moss et al. 2010). The RCPs are labeled according 
to the approximate global radiative-forcing level at 2100, 
with RCP 2.6 estimating the lowest amount of climate 
change by the year 2100, and RCP 8.5 estimating the high-
est amount of climate change by 2100. 

Figure 3.1. Climate model data (adopted from Aparicio and Zucker, 2015)
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Tutorial

Step 1. Downloading GCM data
Although GCM data can be downloaded from various sources, the most common one is from IPCC, as shown below. 

Figure 3.2. GCM data source from IPCC website

Please follow following steps to download GCM data from this site:

Click the tab “guidance” to get different guidelines regarding how to select scenarios, fact sheet and scenario process-
es for IPCC Assessment Report 5 (AR5). This site has both past climatological data as well as projected data. 

b

Go to Intergovernmental Panel on Climate Change (IPCC) data distribution site:
https://www.ipcc-data.org/

a

Now click the tab discover, view and download data. This page has all the observed climate data, IPCC Assessment 
Report 5 (AR5) observed climate change impacts. Most importantly, this page has the global climate model outputs, 
as shown below.

c
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Click “Results from GCM-Runs for the Fifth Assessment Report (AR5) based on the IPCC-RCP scenarios”, and fol-
lowing page will open.

All the outputs shown here are from The IPCC’s Fifth Assessment Report (AR5), which relies heavily on the Cou-
pled Model Intercomparison Project, Phase 5 (CMIP5), a large climate modelling process coordinated by the World 
Climate Research Programme (WCRP). The format for GCM output from all the RCP is in NetCDF/CF. NetCDF files 
can be opened and visualized in QGIS. For more details, please click the link output format NetCDF/CF (an over-
view is shown in the screenshot below http://cfconventions.org/ ).

e

e

Click “Global Climate Model Output” link, and following page will opend
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To get data for a particular location, you need to click on following link: 
https://pcmdi.llnl.gov/mips/cmip5/data-portal.html., and the page below will open:

f

Click “availability” on the left hand side menu and following page will open. Click the “PCMDI” link to go to the 
webpage for downloading the climate model data.

g

h Before downloading the data, first you need to create account by clicking “Create Account” in top right corner. 
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After logging in, click on the CMIP5 link as shown below.j

The webpage below will open. Now you can choose which climate model and climate variables to download 
data for. Please click the + icon next to “Project” to expand the list of projects, and check on the box next to 
“CMIP5”. Next, click the + icon next to “Experiment” and check the box for “rcp85”. Finally, click the + icon 
next to “Variable Long Name” and check on the boxes next to “Air Temperature” and “Precipitation”. Once all of 
these model components are selected, click the “Search” box and the available models will be displayed. The 
first model displayed is MIROC-ESM-CHEM, generated by the University of Tokyo, the National Institute for 
Environmental Studies, and the Japan Agency for Marine-Earth Science and Technology.

k

Click on “List Files” for the first model in the list (“MIROC-ESM-CHEM”)… To download the precipitation cli-
mate data (“Precipitation flux”), click the “HTTP Download” link for the variable number 25, “pr_Amon_MR-
ROC....”. To download the Precipitation data, click the “HTTP Download” link for the variable “prc_Amon…”

l

After clicking the link, add the requested information (email address, user name, password, First/Last name, 
etc.) and you will receive an “OpenID Login”. After inputting this OpenID and clicking the Login button, you 
can enter your user name and password.

i
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Step 2. Opening the climate model data in QGIS
Although GCM data can be downloaded from various sources, the most common one is from IPCC, as shown below. 

Click on the “Layer” menu and then click “Add Raster Layer”.b

Open QGIS software (See Chapter 2 if you don’t remember how to do this!).a

Select the NetCDF file “pr_Anon….” and click “Open”.c

Then click “Add”. Then choose the desired coordinate reference system (“WGS 1984”) and click “OK” to add the 
NetCDF layer in QGIS.

d

To understand this layer, click on it in the “Layers” menu. By default, it shows as a “Multiband color” image, with 
model results for 3 years shown as a color map. 

e
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h Now try to download and display the data for the average maximum monthly temperature variable (“tasmax” 
variable) 

As you can see, the resulting map shows the spatial distribution of precipitation for the month of December in the 
year 2100. To convert these precipitation flux measurements (in units of kg/m2/s) to average millimeters of precip-
itation per day, these values would need to be multiplied by 86,400. To convert to monthly precipitation, they would 
then be multiplied by the number of days in the month of interest (i.e. 31 in the case of December).

g

Congratulations, you’ve learned how to download and visualize climate model data in QGIS!

Change this to “Singleband gray” to visualize the climate model results for a single month. As you can see, 
the dates are indicated by the number of days since 01/01/1850 (January 01, 1850). Please select Band 1140: time 
=91660.5 (days since 1850-1-1), this corresponds to the month of December in the year 2100.

f



Chapter 3: Clim
ate change scenario analysis

31

References

Abbs, D., McInnes, K., Rafter, T. (2007) The impact of climate change on extreme rainfall and coastal sea levels over south-east 
Queensland. Departmental report by CSIRO, Victoria, Australia, pp.39.

Aparicio, I.G., Zucker, A. (2015) Meteorological data for RES-E integration studies- State of the art review; EUR 27587; 
10.2790/349276. 

Dore, M.H.I. (2005) Climate change and changes in global precipitation patterns: what do we know? Environmental Internation-
al, 31 (8): 1167-81.

IPCC (2014) Climate Change 2014: Synthesis Report. Contribution of Working Groups I, II and III to the Fifth Assessment Report 
of the Intergovernmental Panel on Climate Change [Core Writing Team, R.K. Pachauri and L.A. Meyer (eds.)]. IPCC, 2014, Geneva, 
Switzerland, pp 151.

Klein, R.J.T., Schipper, E.L.F., Dessai, S. (2005) Integrating mitigation and adaptation into climate and development policy: three 
research questions. Environmental Science and Policy 8(6), 579–588. DOI:10.1016/j.envsci.2005.06.010

Mishra,  B.K.,  Herath  S. (2011) Climate  Projections  Downscaling  and  Impact Assessment   on   Precipitation   over   Upper   
Bagmati   River   basin,   Nepal, Proceedings of 3rd International Conference on Addressing Climate Change for  Sustainable  De-
velopment  through  Up-Scaling  Renewable  Energy  Technologies, 275-281.

Moss, R.H., Edmonds, J.A., Hibbard, K.A., Manning, M.R., Rose, S.K., van Vuuren, D.P., Timothy, R., Carter, T.R., Emori, S., Kainuma, 
M., Kram, T., Meehl, G.A., Mitchell, J.F.B., Nakicenovic, N., Riahi, K., Smith, S.J., Stouffer, R.J., Thomson, A.M., Weyant, J.P., Wil-
banks, T.W. (2010) The next generation of scenarios for climate change research and assessment. Nature, 463:747–756.



32

Chapter 4: Flood impact assess-
ment using HEC-RAS software

Milben A. Bragais 
Brian A. Johnson

As discussed in Chapter 1 and Chapter 2, land-use changes and climate change of-
ten have impacts on flood hazard and exposure. This chapter gives an overview of 
tools and methods for flood modeling, which can help to understand and visualize 
the impacts of these changes on flood extent given a certain rainfall event. The 
chapter also provides a tutorial for simulating flood hazard using free software like 
QGIS, HEC-HMS, and HEC-RAS, providing step-by-step instructions on data prepa-
ration, rainfall and runoff curve generation, flood simulation, and flood extent com-
putation. Using current and future (predicted) land-use maps as inputs in the flood 
modelling, you will be able to quantitatively compare the effects of land-use change 
as the flood extent.

Overview of this chapter

After completing the chapter, you will be 
able to:

Prepare data for flood modeling using QGIS software;

Generate rainfall and runoff curve using HEC-HMS

Compare the flood extent of the two scenarios in a simple overlay visualization

Conduct hydraulic modeling using HEC-RAS software to simulate the water movement 
and flood extent under two land-use scenarios;
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Main concepts

Flooding is one of the most significant climate-related 
hazards globally, so simulation and mapping of flood 
hazards is critical for disaster risk reduction and climate 
change adaptation efforts. The availability of free soft-
ware and tools for flood modeling and visualization like 
QGIS, HEC-HMS, and HEC-RAS make it possible to con-
duct flood hazard impact assessments and use the results 
for science-based decision, e.g. to improve local land-
use plans, disaster plans, and climate change adaptation 
plans to make the landscape less susceptible to flooding.
 
The flood modelling process requires a lot of data prepara-
tion using GIS. One of the best tools for this is the free and 
open-source GIS software known as QGIS, introduced in 
Chapter 2. This application enables the user to store, view, 
edit, analyze, and visualize geospatial data. It helps flood 
modelers to handle data efficiently and prepare input that 
can be opened across any GIS and flood modelling plat-
forms. Along with QGIS, HEC-HMS and HEC-RAS are addi-
tional free softwares that offer hydrologic and hydraulic 
modelling capabilities, respectively. 

HEC-HMS, or the “Hydrologic Engineering Center, Hy-
drologic Modeling System” is a numerical model that 
simulates watersheds and channels to predict the flow, 

stage and timing of runoff, or simply the generation of a 
rainfall and runoff curve. HEC-HMS was developed by the 
United States Army Corps of Engineers, and is designed to 
simulate the complete hydrologic processes of watershed 
systems. The output in this modelling, the hydrograph for 
a rainfall event, is used as an input to conduct hydraulic 
modelling using HEC-RAS software. 

HEC-RAS, or the “Hydrologic Engineering Center, River 
Analysis System” is a computer program designed to 
model water flow through systems of open channels and 
surface profiles. As with HEC-HMS, HEC-RAS is also de-
veloped by the United States Army Corps of Engineers, 
and both are available online for free download and use 
(HEC-HMS: https://www.hec.usace.army.mil/software/
hec-hms/downloads.aspx, HEC-RAS: https://www.hec.
usace.army.mil/software/hec-ras/download.aspx). The 
main output of HEC-RAS is a map of the flood extent and 
the behavior of the flood water as it runs over the terrain. 
Using the current and future land-use/land cover maps 
as inputs in the flood modelling, researchers can analyze 
the effects of the land-use/land cover change on the flood 
extent under different development scenarios, as shown 
in the example in Figure 5.1. 

The remainder of this chapter is a tutorial for using QGIS, 
HEC-HMS, and HEC-RAS, which utilizes data from a case 
study site, the Silang-Santa Rosa subwatershed in the Phil-
ippines. Because this is a long tutorial, we have broken it 
down into three separate Modules. Module 1 focuses on data 
preparation using QGIS, Module 2 focuses on flood simula-
tion using HEC-HMS and HEC-RAS, and Module 3 focuses on 
visualizing the outputs  of the flood simulation using QGIS. 

Figure 4.1. Comparison of flood extent under two different land-
use scenarios (current condition and future planned land-use). 
Overlaying the results can show how the future condition will 
be impacted by planned land-use changes.
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Tutorial

Module 1: GIS Data Preparation using QGIS

QGIS version 3.14

QuickMapServices plugin

Digital elevation model (DEM)

Shapefiles (Land cover, Administrative boundary, River 
polylines)

River discharge data in excel file

1. 

2. 

3.

4.
 

5.

To download and install the needed software for the 
input preparation;

To check the integrity of the needed data by checking 
its properties and attribute table; 

To prepare and format the data layers like the water-
shed boundary and river polylines; and

To organize other data to be used in the flood simula-
tion like the discharge data in excel file. 

1.
 

2.
 

3.

4.

Objectives
The objective of this module is to inspect and / or pre-
pare the GIS data needed for the flood modelling. Spe-
cifically, this module discusses how:

Materials

Software Download and Installation

Select the version that suits your workstation. Click the download icon to start downloading the software. 

Visit qgis.org to download the latest QGIS software version. QGIS is a free and open source geographic information 
system.

a

Install the version of QGIS that was downloaded. Click next to start the installation and click finish after the setup is 
completed. 

b
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Data Inspection

Open QGIS then load the given Raster (DEM1) and Vector (Watershed boundary2, Laguna lake boundary3, river 
polylines4,  current land cover polygon5, and future land cover polygon6) data.

a

Inspect the properties of each layer. Right click on the layer on the table of contents (TOC) then click properties. On the 
properties window, click the information tab and check the coordinate reference system (CRS) of the layer.

b

Data

RASTER

•  DEM

Layer Name

•  Laguna_IfSAR.tif

CRS

EPSG:32651 - WGS 84 / UTM 
zone 51N – Projected

VECTOR

•  Watershed boundary shapefile

•  Laguna lake boundary shapefile

•  River shapefile

•  Current land cover shapefile

•  Future land cover shapefile

•  srr_watershed_boundary

•  lagunalake.shp

•  river.shp

•  CurrentLC_2014.shp

•  FutureLC_2025.shp

EPSG:32651 - WGS 84 / UTM 
zone 51N – Projected

IfSAR (Interferometric Synthetic Aperture Radar) derived DTM with 5m x 5m resolution from National Mapping and Resources Information Authority (NAMRIA)
Silang-Sta. Rosa Subwatershed boundary from Laguna Lake Development Authority (LLDA) GIS data
Laguna Lake boundary extracted from the administrative data boundary downloaded GADM website 
Silang-Sta. Rosa subwatershed tributaries digitized using Google Earth satellite image
2014 Land cover generated using Landsat 8 from the United States Geological Survey (USGS)
2025 Land cover from the participatory mapping activity participated by the Local Government Units in the subwatershed

1
2
3
4
5
6
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Zoom in the Map display to see if the river network is plotted correctly in the map. Edit the river shapefile if there 
are incorrectly plotted polylines. Right Click the river layer in the TOC > click Toggle Editing. On the toolbars, click 
Vertex Tool (Current Layer) then hover your cursor in the river section to be adjusted. Adjust the vertext of the river 
section to correct part in the map. Once finished, click Toogle editing icon in the toolbar then click save to save 
and stop the editing mode. 

e

Opening QuickMapServices plugin and loading of Google satellite image to see if the river network is plotted cor-
rectly in the map. Click Web > QuickMapServices > Google > Google Satellite. After the Google satelite is loaded in 
the Map display, please uncheck the other layers in the table of contents except srr_watershed_boundary, river, 
and Google Satellite. 

d

Add plugin to load satellite image as basemap. Click the Plugins tab > click Manage and Install Plugins > the wait 
for the Fetching repositories window to finish fetching > click All on the Plugins window then type QuickMapSer-
vices on the space > click Install Plugin > wait for the installation to finish then click Close. 

c
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Save the project as Module1_Exercise inside the Flood Modelling folder. f

See that the project is now named as Module1_Exercise located in the upper rigt of the QGIS display. 

Checking the river discharge data in Exel file collected using a capacitive water level logger installed in the dam 
inside the watershed. Take note of the recorded starting and ending time and date. Make sure to have the comput-
ed discharge voulume in cubic meter per second (m3/s)

h

Checking the attribute table of the two land cover layers. Right click the CurrentLC_2014 layer in the TOC > click 
Open Attribute Table. Make sure that the table has LCOVER and MannN columns for the land cover classes 
and Manning’s roughness coeeficient values, respectively. Do the same to check the attribute table of the Fu-
tureLC_2025 layer to see if it has LCOVER and MannN columns. 

g
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Module 2: Flood Simulation using HEC-HMS and HEC-RAS 

HEC-HMS version 4.7.1

HEC-RAS version 5.0.7

QGIS version 3.14

Data from Module 1 (DEM, Shapefiles, Rainfall, and Dis-
charge data)

1. 

2. 

3.

4.To download and install HEC-HMS and HEC-RAS to 
conduct the flood simulation;

To use the data from module 1 to generate hydrograph 
and prepare geometric and unsteady flow data input in 
the flood modelling software;

To conduct unsteady flow analysis between the current 
and future land cover layers as sources of the Man-
ning’s roughness coefficient values; and

To download and compute the resulting maximum 
flood extent generated after running both the unsteady 
flow analysis of the current and future land cover lay-
ers.

1.
 

2.
 

3.

4.

Objectives
The objective of this module is to conduct hydrologic and 
hydraulic simulation to compute and compare the flooded 
area under the current and future land cover data. Specifi-
cally, this module aims:

Materials

Software Download and Installation

Visit hec.usace.army.mil website to download the latest HEC-HMS and HEC-RAS software versions. a

Download and install the both HEC-HMS 4.7.1 and HEC-RAS 5.0.7 setup Packages and Documentation under the Pri-
mary Download Site for Windows. Double click the downloaded software > click Next > Choose I agree to the above 
Terms and Conditions for Use > click Next to define the Destination Folder > Click install the lastly, click the Finish 
button. 

b
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Create simulation run using the Compute Tab > click Compute icon > copy the Predicted Inflow in the Time-Series Re-
sults table to be used in the hydraulic modelling.

c

Import the basin model prepared using GIS software and create Meteorologic Models, Control Specifications, and 
Time-series Data under Components tab.

b

Creating a HEC-HMS Project

a Double click the HEC-MHS icon   in the desktop. Under the File tab, click Save Project As > locate the folder to 
save the project > type SantaRosaRiver under the Title space as the project File Name.
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Creating a HEC-RAS Project

Under the Option tab, click the Unit System (US Customary/SI)… Select System International (Metric System) and tick 
Set as default for new projects > click OK.

b

Double click the HEC-RAS icon  in the desktop. Under the File tab, click Save Project As > locate the folder to save 
the project > type SantaRosaRiver under the Title space as the project File Name.

a

Go to Flood Modelling >Data > Shapefile folder and select river.prj > click OK.b

Loading Map layers using RAS Mapper

a Click this icon            in the HEC-RAS window. Under the Tools tab of the RAS Mapper window, please click Set Projec-
tion for Project…Browse the data where you can find a projection file that can be used for your project area. 
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Navigate to the Data folder then click Laguna_IfSAR.tif > click Open.d

Under the Tools tab of RAS Mapper, click New Terrain… > click the ‘+’ sign to add the DEM data. c

Under the New Terrain Layers click Create. Wait as the RAS Mapper window create terrain then click the close button 
once done.  

e

See that a Terrain layer is now on the TOC. 

Under the Tools tab of RAS Mapper, click New Land Cover… > click the ‘+’ sign to add the current land cover layer.f
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Under the Tools tab of RAS Mapper, click Add Web Imagery… > select Google Satellite > click OK. i

See that Google Satellite layer is now on the TOC. 

Under the Tools tab of RAS Mapper, click Add Map Layers… > Navigate to the Data folder > under the Shapefile folder, 
select lagunalake.shp, river.shp, and srr_watershed_boundary. shp > click Open.

j

See that three new map layers are added to the TOC, Lagunalake, River, and srr_watershed_boundary.  

Select LCOVER and MannN columns in the provided space > click Create > click Close.h

See that a new map layer, Mannings_n is now on the TOC. 

Navigate to the Data folder then click CurrentLC_2014.shp > click Open.g
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Click Select layers to view in background icon > tick river and srr_watershed_boundary layers > click Close.b

Create 2D Flow Area. Zoom in to the downstream area. Click 2D Flow Area icon > trace the downstream area > double 
click to end digitizing > type Flow Area as the name for the created 2D flow area > click OK. 

c

Geometric Data Preparation

Click the View/Edit geometric data icon.a
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Click File tab under in the Geometric Data window > click Save Geometric Data > type SRR as the Title of the Geomet-
ric Data > click OK.   

e

Open RAS Mapper window. Right click Mannings_n > click Associate with Geometry > click OK > select Mannings_n 
in the manage Geometry Association window > click Close. 

f

Click Edit 2D Flow Areas > click Generate Computation Points on Regular Interval with All Breaklines… > type 5 for the 
Computation Point Spacing for both Spacing DX and Spacing DY > click Generate Points in 2D Flow Area > click OK.   

d
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Go to Geometric Data – SRR window. Click Edit 2D Flow Areas > click Edit Land Cover to Manning’s n… > click OK.g

Create Boundary Condition Inflow. Zoom in to the upper portion of the Flow Area. Click SA/2DArea BC Lines icon > 
trace a line across the river in the inflow area > double click to end digitizing > type Inflow as the name of the bound-
ary condition > click OK. 

h

Create Boundary Condition Outflow. Zoom in to the lower portion of the Flow Area. Click SA/2DArea BC Lines icon > 
trace a line across the boundary in the outflow area > double click to end digitizing > type Outflow as the name of the 
boundary condition > click OK > go to File tab > click Save Geometry Data.

i
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Under the Boundary Condition column, click the blank space in row 1 > click Normal Depth under the Boundary Con-
dition Types section > type 0.01 for the Friction Slope > click OK.

b

Open the Discharge excel file under the Data folder. Use the data in the excel file to fill up the Flow Hydrograph win-
dows’ information need. 

c

Unsteady Flow Data Preparation

Click the Edit tab > click Unsteady Flow Data a
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Under the Boundary Condition column in the Unsteady Flow Data window, click the blank space in row 2 > click Flow 
Hydrograph under the Boundary Condition Types section > input 1 minute for the Data time interval > select Fixed 
Start Time then input Date: October 24, 2012 and Time: 1330 > click No. Ordinates tab > type 2751 > click OK > copy the 
Observed Discharge values in the excel file the paste it in the Flow column in the Flow hydrograph window > input 0.05 
in as the EG Slope for distributing flow along BC Line > click Plot Data to check the hydrograph > click OK.

d

Click File tab under in the Unsteady Flow Data window > click Save Unsteady Flow Data > type Ofel as the Title of the 
Unsteady Flow Data > click OK.   

e

Unsteady Flow Analysis

Click the Run tab > click Unsteady Flow Analysisa
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Click the File tab in the Unsteady Flow Analysis window > click Save Plan > type Current as Title of the plan > type 
2014 as short ID > click OK.

b

Wait to finish the computation > congratulations if you see the three blue bars > click Close.

Tick all (except sediment) under Programs to Run section > input starting date and time: October 24, 2012, 1330 > input 
starting date and time: October 26, 2012, 1120 > select 1 Minute for both Computational Interval and hydrograph Output 
Interval > select 10 Minutes for both Mapping Output Interval and Detailed Output Interval > click File tab > click Save 
Plan > click Compute.

c

View and Export Results in RAS Mapper

Open RAS Mapper > view the Depth in TOC > click the Play icon to see the flood simulation.a
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Right click Depth layer > click Edit Map Parameters > tick Maximum for the Unsteady Profile and Polygon Boundary 
at Value under the Map Output Mode section > click Save Map.

b

See that the maximum flood extent boundary has been created.

Right click Inundation Boundary in the TOC > click Compute/Update Stored Map (Map not created).c

Export result as Shapefile. Right click Inundation Boundary in the TOC > click Export Layer > click Save Features to 
Shapefile > navigate to Output folder to save the file.

d
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Run the Simulation for Future Landcover

Repeat the process in adding New Land Cover data but this time, use the FutureLC_2025.shp.

Under the Tools tab of RAS Mapper, click New Land Cover… > click the ‘+’ sign to add the future land cover layer.

a

Navigate to the Data folder then click FutureLC_2025.shp > click Open.b

See that a new map layer, Mannings_n is now on the TOC. 

Select LCOVER and MannN columns in the provided space > click OK for the Overwrite window > click Create > click 
Close.

c
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Open RAS Mapper window. Right click Mannings_n > click Associate with Geometry > click OK > select Mannings_n 
in the Manage Geometry Association window > click Close. 

d

Go to Geometric Data – SRR window. Click Edit 2D Flow Areas > click Edit Land Cover to Manning’s n… > click OK.e

Create a new plan under the Unsteady Flow Analysis. Name the plan Future with short ID: 2025. Run the simulation 
and repeat the process of viewing the results in RAS Mapper and exporting results in shapefile. Name the ouput 
shapefile as Future_flood.

f
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Flood Area Computation 

Open QGIS > click Add Vector Layers > navigate to the Output folder > select both current and future flood extent 
shapefiles > click Open > click Add > click Close.

a

Right click the Current Flood layer in the TOC > click Open Attribute Table > click the Toggle editing mode icon > click 
New field > type Area_ha for the Name > select Decimal number (real) for the Type > click OK.

b

Click Open field calculator > tick Update existing field > choose Area_ha > find Geometry, double click on $Area then 
type / 1000 > click OK.

c

The Area of the Current_flood shapefile is 6,143.89 
hectares. Click Toggle editing mode icon to stop edit-
ing > click Save.

Module 3: Flood Extent Comparison using QGIS

QGIS version 3.14

QuickMapServices plugin

Shapefiles (Watershed boundary, river polylines, and 
flood extent boundaries)

1. 

2. 

3.
To compute the area in hectares of the two flood ex-
tents; 

To stylize the two flood extents; and

To overlay the two flood extent layers in preparation for 
map lay-out.  

1.

2.

3.

Objectives
The objective of this module is to compare the flood extent 
of the two land cover scenarios. Specifically, this module 
discusses how:

Materials
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Do the same process in number 1 for the Future Flood layer. 

The Area of the Current_flood shapefile is 6,816.17 hectares.
d

a

Stylizing the Layers

Right click the Current Flood layer in the TOC > click Properties… > click Symbology tab > click Simple fill > click the 
color bar in front of Fill color and change it to Blue using the color wheel > click OK >under the stroke style, select No 
Pen > click OK.

Do the same process in number 2 for the Future Flood layer. This time choose color Red for the Fill color section. b
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Save the project. Go to File tab > click Save > navigate to Output folder > type Flood_extent for the File name > click 
Save.

c

Load watershed boundary layer. Click Add Vector Layers > navigate to the Data folder > select srr_watershed_bound-
ary.shp > click Open > click Add > click Close.

d

Right click the river layer in the TOC > click Properties… > click Symbology tab > click Simple fill > under the Fill style, 
select No Brush > under the stroke color, choose Black color from the color wheel > click OK > under Stroke width, input 
1 > click OK.

e
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Add Google satellite image. Click Web > QuickMapServices > Google > Google Satellite. After the Google satelite is 
loaded, arrange the layers in the TOC in order from the top to bottom: srr_watershed_boundary, Current_flood, Future_
flood, and Google Satellite. 

f
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Chapter 5: Water quality impact 
assessment

Pankaj Kumar
Brian A. Johnson

Surface water quality is closely linked to human activities (e.g. water demand, 
wastewater discharge/runoff, and land-use/land-management) as well as local 
climate conditions. Thus, changes in population, water treatment infrastructure, 
land-use, and climate all result in modification of the water quality of nearby rivers/
lakes/coastal waters.
 
This Chapter will show you how to simulate the future water quality of a watershed 
using the “Water Evaluation and Planning System” (WEAP) software package, which 
is free for users in developing countries. You will learn to conduct several different 
types of scenarios, to understand and model the impacts of population growth, in-
frastructure development, land-use change, and climate change on water quality.

Overview of this chapter

This chapter will introduce you to GCMs and downscaling, and show you how to ac-
cess downscaled climate data. 

After completing the chapter, you will be 
able to:

Use WEAP software to estimate the water quality of a watershed;

Integrate future population projections, infrastructure-related information, land-use, 
and climate information to develop different scenarios of the future water quality.
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Main concepts

Improving urban water environment is of great signifi-
cance, considering the importance of clean water for bio-
diversity and ecosystem services. Clean water is needed to 
ensure healthy fish stocks, and that water is clean enough 
for recreational activities, bathing, tourism, cultural and 
religious activities, etc. To analyze the sustainability of 
future urban development with regards to water resourc-
es, various scientific tools can be used, e.g. to forecast the 
future state of urban water environment under different 
scenarios. These tools are useful in that their outputs 
provide science-based evidence for decision-making, and 
the involvement of local stakeholders in the process can 
improve the modeling results (e.g. by better accounting 
for the local context) as well as build the capacities of the 
stakeholders involved in water management.

This chapter presents the Water Evaluation and Planning 
(WEAP) took, a computer modeling tool that takes into ac-
count hydrological and water quality components to an-

alyze/simulate the current/future water quality. WEAP is 
widely used as a decision support tool for integrated water 
resources management and planning. The model allows 
for the estimation of rainfall runoff and pollutant trans-
port from a catchment to nearby water bodies. WEAP can 
support environmental master planning functionalities 
by accounting for wastewater generation and treatment, 
and includes a catchment module for rainfall-runoff sim-
ulation (an essential input parameter for water quality 
modeling. Other benefits of WEAP are that it is not data 
intensive, and that it is freely available to people in devel-
oping countries.

In this chapter, we will show how the WEAP model 
can be used to simulate future total water demand and 
water quality variables (targeting the year 2030) in the 
Santa Rosa watershed of the Philippines, and to assess 
different management policies.

To run the WEAP tool, first vector or raster file of admin-
istrative boundary of the study area and river map is im-
ported into the software. After tracing the river on the top 
of the administrative map, we create our problem domain. 
The whole problem domain (and its different components) 
is divided into several sub-catchments, which are further 
subdivided into different sub-basins, to consider influent 
locations of river and its major tributaries being repre-
sented by respective WEAP nodes. Other major consider-
ations are many demand sites (number usually depend on 
lower administrative unit of study area by which data is 
available) and wastewater treatment plant to accurately 
represent the current situation of the study area. Here, 
demand sites denote domestic (population) defined with 
their attributes explaining water consumption and waste-
water discharge in concerned river. As a countermeasure, 
Wastewater treatment plants (WWTPs) are considered as 
pollution handling facilities with design specifications 
including total capacity and removal efficiencies of pol-
lutants. In this case, an upflow anaerobic sludge blanket 
reactor (USAB) type of wastewater treatment plant with its 
pollutant removal efficiency is considered in the model-

ing. The daily volume of domestic wastewater generation 
in this area of the Philippines ranges from around 100-180 
liters per day per capita, however because of non-avail-
ability of precise data in some of the areas it was fixed at 
130 liters of average daily consumption per capita. Apart 
of this, we do need to plot river gauge stations, ground 
water supply and finally different types of links (return 
flow, transmission flow, and runoff/infiltration) to finalize 
model set-up.

Scenario analysis is carried out by defining a time 
horizon for which alternative wastewater generation 
and management options are explored, which is 2030 
in this case. The business as usual condition is repre-
sented by a reference scenario with selection of all the 
existing elements as currently active. Consequently, 
new WWTPs (hypothetically considered as counter-
measures) are modeled as scenarios representing devi-
ations from the current conditions (reference scenario). 
The baseline year under the current reference scenario 
for all study areas also varies based on the past data 
availabilities.

Model set-up
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Before doing future scenario analysis, performance of the 
WEAP simulation should be assessed based on the asso-
ciation between the observed and simulated values of the 
hydrological and water quality parameters. For this Chap-
ter’s case study, hydrology module parameters (mainly ef-
fective precipitation and runoff/infiltration) were adjusted 
during simulation in order to reproduce the observed 
monthly stream flows for the period of certain year for 
hydrology module validation. Whereas the water quality 

simulation part is validated by comparing the simulated 
and observed concentration of water quality concentra-
tions at some observation points. Selection of the loca-
tions and times in the case presented in this Chapter were 
made on the basis of consistent availability of observed 
water quality data. Once satisfactory correlation between 
observed and simulated values were confirmed statisti-
cally, future simulation for both water quality and hydro-
logical parameters were initiated. 

Model performance evaluation

Parameter Initial Value

Effective precipitation 100%

Runoff/infiltration ratio 50/50

Household discharged water quality parameters
concentrations both at the observation site and river head X mg/L or CFU/100ml 

Step

±0.5%

±5/5

±0.5%

Tutorial

WEAP (Water Evaluation and Planning) model is used based on the following benefits:

Risk assessment (For water quality component) 

Freely available for developing countries 

WEAP can model large number of pollutants

GIS-based, graphical drag & drop interface

Scenario management capabilities

A highly flexible hydrologic-water quality model

Expected outcome

It will also help to identify what are the suitable 
mitigation/adaptation measures for improving this 
water environment and what is the best strategic lo-
cation to establish these infrastructures as counter-
measures

2With scenario based simulation, we will be able to 
predict what will be the future situation of the water 
environment

1
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Looking in to the flowchart of the model framework, it has four major components viz. WEAP model set up (schematic dia-
gram and data input), calibration, validation and finally simulation. Structure of the model consists of four components e.g. 
schematic diagram, data input, scenario analysis and finally evaluation of scientific data for policy formulation (providing 
credible scientific evidence for policy formulation).  

The WEAP model framework and model structure are shown in the two images below. 

WEAP 
model set 

up 

• Initial data preparation (GIS layers, river cross section, water quality, hydro-
meteorological parameters, wastewater management infrastructures etc.) 

• Model set up was done for the base year (2013) using Rainfall-Runoff method

Calibration

• Model calibration using trial and error trial on hydraulic (effective precipitation, 
runoff/infiltration), and water quality (BOD) parameters 

• Satisfactory statistical performance 

Validation

• Correlation between observed and simulated data for both hydraulic and water 
quality parameters 

• Satisfactory statistical performance 

Simulation
• Scenario building [two scenarios: a) Business as usual, b) With measures] 

Policy recommendation based on the scientific findings for making robust future 
plans for water resource management  

Flowchart showing work framework.

Flowchart showing model structure.

Scenario Building
Both scenarios are based on current account 

(a) Business as usual (Here main input data will be change in population and precipitation from 2015 onwards)
(b) With measures (Here main input data will be change in population, precipitation, sewerage collection rate and capacity of WWTPs)

Current Account
(a) Demand and wastewater generation (based on population and per capita water consumption/day);  (b) River runoff (function of river cross section at 

various locations and precipitation at catchment site); (c ) Water quality at river head; (d) WWTPs (Pollutant removal facility works as a function of sewerage 
collection rate and removal efficiency); (e) Simulation (calibration and validation) 

Study Definition 
a) Spatial boundary (city administrative boundary, river stretch within the city); b) Time Horizon  (2013 -2030); c) System components  (Different nodes like 

Demand site, WWTPs, Catchment site, Groundwater); (d) Network configuration (each node will be linked with different links viz. return flow, 
runoff/infiltration, transmission), all nodes and links are based on mass balance equation   

Evaluation
(a) Pollutant loading

(b) Efficiency of existing policies and plans

}Schematic

}Data

}Scenario

}Evaluation

WEAP 
components
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Steps needed prior to proceeding with this WEAP tutorial

Copy the “WEAP_training_St_Rosa” folder, contain-
ing the data necessary for this tutorial. Now, you are 
ready to move on to Step 1 of this tutorial

bBefore working with WEAP software, download and 
register it from http://www.weap21.org/. After that, 
you will need to request and procure the free license 
to proceed.

a

A window, as shown below, will appear in which you should click on the “Initially Blank” option. In the next steps, you 
will be defining this area for a specific geographic area of the world - so you can name the area based on this selection 
if you like (e.g., St Rosa Area). 

d

After clicking “OK” you will be prompted to save changes to the Santa Rosa River Basin. After clicking yes, you will get 
the following screen:

c

Step 1. Establish a New, Blank Area. 

Open WEAP for the first time. A project area called “Weaping River Basin” will appear. Click on the Area -> Create Area 
menu option to make a new, blank area.

a



Chapter 5: W
ater quality im

pact assessm
ent

61

Click “OK” again. In the next screen, you will select the geographic area for your project from the world map that ap-
pears. Use your cursor to draw a rectangle around the area that your project will represent. The boundaries will ap-
pear as a green rectangle as shown below.

d

You can then use the slider bar on the lower left of the window to zoom into this selected area.e

You can redraw you green rectangle to best capture the area you want in this view. Click on “OK” when you are satis-
fied with your area boundaries. Note that you can modify these boundaries later by choosing “Set Area Boundaries” 
on the pull-down menu under Schematic on the top menu bar.

f
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Step 2. Add a GIS layer to the Area 

You can add GIS-based Raster and Vector maps to your project area - these maps can help you to orient and construct 
your system and refine area boundaries. To add a Raster or Vector layer, right click in the middle window to the left of 
the Schematic and select “Add a Raster Layer” or “Add a Vector Layer.”

a

A window will appear, in which you can navigate to the “WEAP_training_St_Rosa” folder. Add the “SantaRosaSubwa-
tershed.shp” file in this folder. After adding  the file it will look like as follows: 

b

Next, add the “waterwaysSR.shp” file, which contains the river network in the study area. And now toggle off the other 
background layers like country, cities, state as shown in the figure below

c
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Step 3. Setting General Parameters
Now we’re going to proceed with learning how to navigate through WEAP and its functionalities. 

Here the year 2013 will serve as the “Current Accounts” year for this project. The Current Accounts year is chosen to 
serve as the base year for the model, and all system information (e.g., demand, supply data) is input into the Current 
Accounts. The Current Accounts is the dataset from which scenarios are built. Scenarios explore possible changes 
to the system in future years after the Current Accounts year. A default scenario, the “Reference Scenario” carries 
forward the Current Accounts data into the entire project period specified (here, 2013 to 2030) and serves as a point of 
comparison for other scenarios in which changes may be made to the system data.

Set the Current Accounts Year to 2013 and the Last Year of Scenarios to 2030. Set the Time Steps per year to 12. Set the 
Time Step Boundary to “Based on calendar month” and starting in January (see below) Keep the default (SI units) for 
now.

b

Similarly, under “General”, the units also be set.c

Click “General” from menu and using drop down menu select different options and set the different parameters like to 
set Years and Time Steps. 

a
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However if we need to add other parameter, we can do that after click add button and adjust units as our observed data 
as shown below. 

e

Step 4. Save a version of your Area

Select “Save Version” under the “Area” menu. After saving all the files will be saved in folder named as WEAP area 
where your set up file are there.

a

Next if we want to do the simulation of water quality parameters, we need to select general—water quality parameters 
and must click enable water quality modeling. By default,  WEAP will simulate temperature, BOD and DO.

d
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Step 5. Entering Elements into the Schematic
First, we will draw a River 

Click on the “River” symbol in the Element window and hold the click as you drag the symbol over to the map. Release 
the click when you have positioned the cursor over the upper left starting point of the main section of the river. Move 
the cursor, and you will notice a line being generated from that starting point.

In the next several steps, you will draw the main river, drawing from the upstream (upper left) to the downstream (lower 
right) area, clicking once to end each segment that you draw. You can follow the line of the river as closely as you like, 
or you can draw a less detailed representation (below). Note though, that how closely you follow the actual course of 
the river will have implications for the performance of certain functionalities in WEAP. For example, if you plan to 
model water quality parameters along the river, it would be advantageous to construct the river element as closely 
as possible to the actual river course, because WEAP will need to calculate residence times in the river (a function 
of reach lengths) to perform water quality simulations. Zooming in on the river (using the zooming bar in the lower 
schematic window) can help if you want to follow the rivers path more closely. You do not need to draw a river on the 
branch coming horizontally from the left. You can also adjust the river later if you want to add more detail.

a

Important Note- The direction of drawing matters: the first point you draw will be the head of the river 
from where water will flow. You can edit the river course later on by simply clicking-moving any part 
of the river to create a new point, or right-clicking any point to delete it.

First deselect country and other information not necessary for the schematic diagram development.b

Click on the symbol river in the element window. c
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Now remove background layer of river network from GIS layer we have imported before as shown below.e

Now to adjust the size of river node in compare to the model domain, click onset WEAP node label size as a dropdown 
menu under schematic tab.  

f

Please start your drawing from the point which you consider as upstream (around the lower left area shown in the red 
box below). Try to draw the river as shown in the image below. Once you finish drawing the river, double click to end 
the drawing. A window will appear ask you to name the drawn river.  Put the name you want. 

d
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Adjust the size putting curser on the zooming tool shown below. Once satisfied click OK.g

Now set the label name using Set WEAP Node Label Size under Schematic. Adjust as per your wish.h

As river name is not appearing on the screen, right click and select move label. And with cursor you can move the 
placement of the label wherever you want. 

i
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Step 6. Enter Data for the Main River
 
There are two ways to navigate to the data entry section of WEAP to enter data for the Main River. Let’s try them.

Right-click on the Main River and select Edit data and any item in the list. a

Switch to the Data view by clicking on the Data symbol on the left of the main screen. Select: Supply and Resources/ 
River /Main River in the Data tree. You may have to click on the “plus sign” icon beside the Supply and Resources 
branch in order to view all of the additional branches below it in the tree. 

b

Alternatively, you can use the Tree pull-down menu and select “Expand All” to view all branches.c

 Finally it will look like screen shown below.j
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The “Inflows and Outflows” window should be open - if it isn’t, click on the appropriate button. Click on the “Headflow” 
tab. 

d

Entering Elements into the Schematic

Use the Monthly Time Series Wizard and enter the following data series:f

Click on the area just beneath the bar labeled “2013” in the data input window to view a pull-down menu icon. Select 
the “Monthly Time-Series Wizard” from the drop--down menu.

e

Note that as you enter each data point, the data is shown graphically also. Do not input or change any other data yet. 
Push Finish to close the wizard.

g

Note- WEAP divides up rivers into reaches (segments). Originally your river has only one reach; as you add with-
drawal and return points, WEAP will automatically create new reaches. 
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You must first select the units before entering data. Click on the “N/A” under Unit in the Annual Activity level tab. Pull 
down the arrow that appears, select “People”, and click “OK.”

c

Step 7. Create an Urban Demand Site and Enter the Related Data 

Creating a demand node is similar to the process you used to create a river. Return to the Schematic view and pull a 
demand node symbol onto the schematic from the Element window, releasing the click when you have positioned 
the node on the left bank of the river (facing downstream) inside the administrative boundary of the study area 
shown in black line. Enter the name of this demand node as “St Rosa” in the dialog box, and set the demand priority 
to 1.

a

b

Right click on the Big City demand site and select “Edit data” and “Annual Activity Level.” This is the alternative way 
to edit data, rather than clicking on the “Data” view icon on the side bar menu and searching through the data tree.

b

Note- The Demand Priority represents the level of priority for allocation of constrained resources among multi-
ple demand sites. WEAP will attempt to supply all demand sites with highest Demand Priority, then moving to 
lower priority sites until all of the demand is met or all of the resources are used, whichever happens first 



Chapter 5: W
ater quality im

pact assessm
ent

71

In the space under the field labeled ”2000”, enter the Annual Activity Level as 296619.d

Next, click on the “Annual Water Use Rate” tab and enter 300 under the year 2013.e

Note- The monthly variation is expressed as a percentage of the yearly value. The values for all of the months 
have to sum up to 100% over the full year. If you don’t specify monthly variation, WEAP will prescribe a monthly 
variation based on the number of days in each month. We will not edit these values for the city demand, but we 
will edit them later for the agricultural demand. 

Finally, click on the “Consumption” tab and enter 15. Note that the units are pre-set to “percent.”f
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Step 8. Create an Catchment and groundwater supply for the demand site

Pull the catchment node symbol into the project area and position it on the river head and name it as “C”. But during 
the complex simulation, we can divide whole study area in to different sub-catchments. It will be used to generate 
river discharge and runoff. 

a

Tick the box for active in current account.b

Now we add groundwater supply, as we will assume people in the study area consume only groundwater c

Add a wastewater treatment plant and named as WWTP.d

Note - For all nodes we should tick the box active in current account except WWTP. As we will make one sce-
nario with proposed WWTPs.
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Step 9. Connect the Demand with a Supply 
You now need to tell WEAP how demand is satisfied. This is accomplished by connecting a supply resource to each 
demand site. Return to the Schematic view and create links to connect catchment, groundwater, river and demand 
sites. Do this by dragging the different links e.g. Transmission Link first to a position on the groundwater, releasing 
the click, then pulling the link to demand site and double clicking on this demand node. 

Create a Runoff/infiltration link to connect catchment to rivera

Create a Return flow link to connect demand site to river.c

Create a flow link to connect demand site to WWTP, and a Return flow link to connect WWTP to river. d

Note- Position of runoff/infiltration link con-
necting catchment to the river matters a lot. 
Be aware that the position you will release 
the click of runoff/infiltration link, will be 
considered as river head in the model by de-
fault. 

Create a Transmission link to connect from the groundwater to demand siteb
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Now within Land Use Tab, fill all the area information for all the land use types, as shown below.c

Step 10. Entering the data 

Select “C” in the assumption tree, first select catchment method. Ideally soil-moisture method is best suitable meth-
od to calculate runoff as it divides the aquifer in two layers vadose zone and saturated zone mimicking the real world 
situation more closely. However number of input data is quite huge. In this case (St Rosa), because of data scarcity, we 
have selected rainfall-runoff (simplified coefficient method).

a

Now give the values for the area of each land-use/land cover type in the study area. Click dataClick C click add and 
add “Agriculture”, “Builtup”, “Grassland”, and “Tree” land-use/land cover types.

b
Data for catchment “C”
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Now click on the climate tab, and open the precipitation monthly time-series wizard.d

Next, click the water quality tab. We can give the input in terms of either intensity or concentration of the water qual-
ity parameters. We will use concentration, setting a value of 12 mg/l, as shown below.

f

Enter the monthly precipitation values, shown belowe
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Now give values for WWTP as a mitigation measures. We gave value for its treatment capacity, removal rate for dif-
ferent contaminants (e.g. BOD as shown below), which we have analyzed in this study as shown in below figure.

j

For the river cross section, click flow stage width as shown below, and give all the input data shown below.i

Now we will give water quality data for the river, but first we have to enable the water quality module within the river 
as shown below.

g

Now give the value of distance marker and river cross section. For distance marker, as the length of river investigat-
ed is 25.5 km, put “0” below river head flow and 25.5 km for the tail flow point.

h
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Step 11. Generate different scenarios
Now once the reference scenario is done, we can start building scenarios to include drivers and pressures which have 
potential to impact water quality in the future. For our simulation case of Santa Rosa, we have built scenarios includ-
ing population growth, climate change, mitigation measures i.e. installing wastewater treating infrastructure.

To build new scenario, click manage scenario, a new window will pop up, where we need to put the name of scenario. 
Then the message will be asked that this scenario is based on. Select reference as shown in the image below:

a

a

Once new scenario is built, then we need to change the concerning parameter in the new scenario, while keeping 
other parameters same as reference. For example, for a scenario considering population growth, annual activity or 
population value will be increased from the reference year to the target year as shown in figure below. 

Similarly, when can build scenarios to incorporate the impacts of climate 
change, land-use change, and new WWTPs. If you’d like to run these differ-
ent scenarios, please see the “WEAP input data readme.doc” file inside the 
WEAP_training_St_Rosa folder for the values to input.

Create a new scenario called popgrowth (2014-2030). Enter the following population values for the years 2014-2030 (in 
the Annual Activity Level tab):

b

Year
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022
2023
2024
2025
2026
2027
2028
2029
2030

D1
St Rosa
296619
310293
324598
338328
352639
367556
383104
399309
415880
433139
451115
469836
489334
509005
529467
550752
572892
595922
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Step 12. Run the model (Calibration, validation, simulation)

Once done with data input and saving the model, press result button. There will a pop-out message which will ap-
pear is “Results are out of date. Do you want to recalculate now?” as shown below. Press yes.

a

After running the model, we might encounter messages like the following:
Demand site return flow fractions must sum to 100 percent. In this the sum 
is 200 percent. It means I have missed allocating the wastewater going to 
WWTP for the treatment and remainder coming back to the river as dis-
charge. 

Click Ok and rectify the issue in the window that will pop out thereafter. 

Click from StRosa from dropdown of return flows on the left side of schematic diagram.b

Now again press result for model simulation, and new window will pop-up showing result for water demand as 
shown below. 

c



Chapter 5: W
ater quality im

pact assessm
ent

79

Now select the desired parameters from the dropdown menu to see the simulated result like water quality as shown 
below.

d

We can also export this simulated result data as an Excel sheet by right clicking on the windows and exporting these 
data sets in to the desired folders. Later you can edit these output to draw different graphs as per your convenience. 

f

We can change the chart type like bar, line, stack etc. based on our interest just by clicking and selecting it from side 
menu. 

e

We can also change the type of graph we wanted to display like no comparison, relative to population growth, land 
use land cover, climate change, and different mitigation measures as shown in the drop down menu shown below.

g

Example: relative to climate change means reference scenario result in compare to climate change scenario
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We can also display the graphs in different ways by selecting the option as shown below. Here result is shown in 
terms of data along with map. 

h

Once satisfied with schematic diagram development for problem domain and giving all necessary input data re-
quired for simulation, calibration followed by validation need to be done to estimate the credibility of the model per-
formance. 

j

The excel file will look this the screen shot shown below.i

Here, the result of the validation in our study is shown in figure below.  It is found that observed value for both param-
eters are significantly related.  

Once statistically satisfied with the model calibration, the next step is validation. For validation, we can compare the 
observed to simulated values of the water quality parameter(s) from base year to current year.

l
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(b)Summary of validation for two water quality parameters i.e. BOD and E.coli

For calibration, following steps were 
used for two parameters (effective pre-
cipitation and runoff/infiltration ratio) 
and the result is shown in the Table be-
low.

k
Summary of parameters used and steps for calibration in this study.

Parameters

Effective precipitation 

Runoff/infiltration ratio

Initial value

100%

50%

Steps

± 0.5%

± 5/5

Final calibrated
value for St Rosa

93%

55/45
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Finally, after validating the model, we can analyze the results of the model simulations. Simulation results for two 
water quality parameters i.e. BOD and E.coli are shown in the two figures below. These figures were produced by ed-
iting the exported data from the model using Microsoft Excel. Please create similar charts using Microsoft Excel or 
your choice of spreadsheet software. As you have only considered the population growth scenario in this tutorial, 
your outputs will be a bit different from those shown below.
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Congratulations, you’ve learned how to perform water quality simulation using WEAP! 

References

Sieber, J., Purkey, D. (2011). Water Evaluation and Planning System. User guide for WEAP21; Stockholm Environment Institute, U.S. 
Center: Somerville, MA, USA; Available online: http://www.weap21.org/. 



82

Chapter 6: Habitat Quality Im-
pact Assessment Using InVEST 
Software

Rajarshi Dasgupta
Brian A. Johnson

Land-use changes can affect biodiversity positively (e.g. restoration of a degraded 
forest), negatively (e.g. conversion of a natural area to built-up land), or in mixed 
ways. The spatial pattern of the land-use changes is also impactful. For example, if 
a large forest patch becomes very fragmented, there may not be enough food, water, 
and other resources in the smaller forest patches for the remaining plants and ani-
mals to survive. In other words, these species lose their home, which is scientifical-
ly referred to as “habitat”. This chapter will show you how to create your own maps 
of the current and future habitat quality, i.e. the ability of the landscape to sustain 
biodiversity, using free Geographic Information Systems (GIS) and ecosystem ser-
vices modeling (InVEST) tools. These maps can help you to conserve the valuable 
biodiversity within your watershed.  

Overview of this chapter

After completing the chapter, you will be 
able to:

Perform basic data collection and pre-process the data

Estimate and map habitat quality using the InVEST ecosystem service model
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Main concepts

Habitat quality refers to the ability of the ecosystem to 
provide conditions appropriate for a species to survive 
(based on the amount of resources available for survival, 
reproduction, and population persistence) (Hall et al 1997).  
Simply put, high habitat quality supports the propagation 
of native biodiversity. In this module, we will learn how to 
conduct habitat quality modeling using the InVEST mod-
el. The InVEST model utilizes habitat quality as a proxy 
for a more detailed biodiversity assessment, which gener-
ally requires more time and cost to conduct (e.g. due to the  
need for intensive field data collection and sampling). In 

other words, InVEST’s habitat quality model provides an 
indirect assessment of the impacts of land use changes 
on biodiversity, i.e. how land-use decisions will contribute 
to the degradation/restoration of biodiversity. Within the 
InVEST model, habitat quality is determined principally 
by four factors: the relative impact of each threat to biodi-
versity, the relative sensitivity of each habitat type to each 
threat, the distance between habitats and the sources of 
different threats, and the degree to which the land is le-
gally protected from these threats. 

What is Habitat Quality?

The InVEST Habitat Quality Model is one of the core mod-
els under the InVEST Suite, which aim to determine con-
servation of biodiversity using landscape patterns and 
fragmentations, using land-use and biodiversity threat 
maps as proxies. As mentioned, InVEST HQ models habi-
tat quality and rarity as proxies for biodiversity, ultimately 
estimating the extent of habitat and vegetation types 
across a landscape, and their state of degradation. Within 
the InVEST environment, Habitat quality and rarity are 

a function of four factors: (a) the relative impact of each 
threat to biodiversity, (b) the relative sensitivity of each 
habitat type to each threat, (c) the distance between habi-
tats and sources of threats, and the (d) degree to which the 
land is legally protected from these threats. The model 
operates on two basic assumptions: that the legal protec-
tion of land is always effective (which may or may not be 
the case, in reality) and that all threats to a landscape are 
additive.

Brief Overview of InVEST Habitat Quality Model 

The current version of InVEST is 3.7. This can be downloaded from the following link. However, it is recommended to work 
on previous version (e.g. 3.6), as the current version may be still under development and may lack some functions. 
Model download page: https://naturalcapitalproject.stanford.edu/software/invest
User Manual: http://releases.naturalcapitalproject.org/invest-userguide/latest/

Where do you find InVEST download links? 

By this time, you must be curious about the InVEST mod-
el. InVEST stands for integrated valuation of ecosystem 
services and tradeoffs. This is a suite of spatially-explicit 
ecosystem services modeling tools developed by the 
famous Natural Capital Project of Stanford University. 
InVEST is a set of 26 biophysical models (many others are 
under development), which can be run independently, or 
as script tools in the ArcGIS/ ArcTool Box environment. 
All of these models are spatially explicit, and thus, use 
maps as input and generate maps as output. It feeds on 
spatial information, while the scope of non-spatial infor-
mation that can be incorporated is more restricted. All 
of the calculations in InVEST are done at the pixel scale 
(e.g. a 30 meter x 30 meter grid cell for many commonly 
used land-use maps). Yet, there are several advantages of 
using InVEST models. Firstly, they are seldom data inten-

sive, and therefore applicable even in data-deficit regions. 
The spatial resolution of this model is also very flexible, 
allowing users to operate at any scale, ranging from local, 
regional, to even global. This gives it an advantage over 
conventional ecosystem service modelling tools, which 
are generally bounded by scales and require a lot of pri-
mary data generation. However, as there is no functional-
ity in InVEST for manipulating or viewing the map inputs/
outputs, we need to use other GIS software like QGIS or 
ArcGIS to prepare the map inputs and view the modelling 
results. Therefore, to operate In-
VEST, a basic understanding of 
GIS software is necessary. Please 
refer to Chapter 2 for informa-
tion on how to use QGIS for data 
preparation and viewing.  

What is InVEST model?
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The InVEST Habitat Quality model combines informa-
tion on land-use/land cover and threats to biodiversity to 
produce habitat quality maps. This approach generates 
two key sets of information that are useful in making an 
initial assessment of conservation needs: the relative ex-
tent and degradation of different types of habitat types in 
a region, and changes across time. This approach further 
allows rapid assessment of the status of and change in 
habitat as a proxy for more detailed measures of biodiver-
sity status. If habitat changes are taken as representative 
of genetic, species, or ecosystem changes, the user is 
assuming that areas with high quality habitat will better 
support all levels of biodiversity and that decreases in 
habitat extent and quality over time means a decline in 
biodiversity persistence, resilience, breadth and depth in 
the area of decline.

The habitat rarity portion of the model indicates the ex-
tent and pattern of natural land cover types on the current 
or a potential future landscape vis-a-vis the extent of the 
same natural land cover types in some baseline period. 
Rarity maps allow users to create a map of the rarest hab-
itats on the landscape relative to the baseline chosen by 
the user to represent the mix of habitats on the landscape 
that is most appropriate for the study area’s native biodi-
versity.

The model requires basic spatial data that are available 
almost anywhere in the world, making it particularly 

useful in areas where species distribution data are poor 
or lacking. Extensive species occurrence (presence/ab-
sence) data may be available in many places for current 
conditions. However, modeling the change in occurrence, 
persistence, or vulnerability of multiple species under 
future conditions is often impossible or infeasible. While 
a habitat approach leaves out the detailed species occur-
rence data, several of its components represent advances 
in functionality over many existing biodiversity con-
servation planning tools; The most significant being the 
ability to characterize the sensitivity of habitat types to 
various threats. Not all habitats are affected by all threats 
in the same way, and the InVEST model accounts for this 
variability. Further, the model allows users to estimate 
the relative impacts of each threat, so that threats that 
are more damaging to biodiversity persistence can be 
represented as such. For example, grassland could be par-
ticularly sensitive to threats generated by urban areas, yet 
moderately sensitive to threats generated by roads. In ad-
dition, the distance over which a threat is likely degrade 
natural systems can be incorporated into the model. Mod-
el assessment of the current landscape can be used as an 
input to a coarse-filter assessment of current conservation 
needs and opportunities. Model assessment of potential 
LULC futures can be used to measure potential changes 
in habitat extent, quality, and rarity on a landscape and 
conservation needs and opportunities in the future. For 
more details regarding the model functions, please see 
the InVEST use guide manual. 

How it works?

In the following tutorial, you will learn how to run the 
InVEST model using sample data prepared for the Santa 
Rosa watershed, Philippines. In practice, habitat quality 
modelling typically requires data preparation in a GIS en-
vironment before inputting it to InVEST. For instance, to 
run the InVEST model, we need to derive maps of various 
threats to biodiversity (e.g. based on distance to roads or 

urban areas), land-use map(s) and the level of perceived 
threat (in grid, or raster, map format). If you have experi-
ence with GIS, preparing spatial data for InVEST is rela-
tively straightforward. Here, we will show how to run the 
InVEST Habitat Quality model, as well as how to prepare 
and view the input/output data in QGIS.  

Tutorial

Open QGIS and start a new project (Click Project -> New). 

Refer back to Chapter 2 if you are unsure how to access or open QGIS.

a
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Add a map of the land-use

Next, we will add the land-use/land-cover maps of the study area, including the year 2015 and 2025 (projected) land-
use/land-cover maps. The process is similar to Step 2. Click the “Layer” menu and then the “Add raster layer” icon. 
Navigate to the “HQA_data/ InVEST HQ Modeling/” folder and add the 2015_LU.tif and 2025_LU.tif files. You can recol-
or these land-use maps as desired for visualization purposes (refer back to Chapter 3 if you can’t remember how to do 
this). 

c

Add a map of streets. 

First, we will add a streets map of the study area. Click the “Layer” menu and then the “Add vector layer” icon. Navi-
gate to the folder “HQA_DATA\Data for pre-processing” and add the Roads_2014.shp file to the map.  

b

Add the “Processing” plug-in for QGIS.

Click on the “Plugins” menu and then click “Manage and install plugins”. Click in the box next to the Processing 
plugin to add plugin to QGIS. Then click “Close”.

d
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Open INVEST Habitat Quality Model

From the Windows “Start” menu, scroll down and 
click “InVEST 3.6” (or whichever version you have) 
and then “Habitat Quality”. The screen shown be-
low will appear. 

g

Generate a “threat map” by applying a 100 meter buffer to all streets

Click on the “Vector” menu, highlight “Geoprocessing Tools”, and then click “Buffer”. Make sure the “Roads_2014” is 
selected as the input layer, and set the Distance to 100 meters.

Save the output to the “Habitat Quality modeling/outputs” folder as a .shp file named “streets_buffered”. Finally, 
click “Run”. This should create a new polygon shapefile, with polygons showing all areas within 100 meters of ex-
isting roads. For this tutorial, we assume that these areas within 100 meters of roads are likely to experience great-
er threat to biodiversity (e.g. due to noise, air pollution, and/or physical disturbances of the landscape). 

a.

b.

e

Convert vector shapefile to raster (.tif) file

Click on the “Raster” menu, highlight “Conversion”, and click “Rasterize (Vector to Raster)”. Set the input layer as the 
buffered shapefile, set the “Fixed value to burn” to 1 (indicating all pixels within the buffer zone will have a value of 1 
in the output raster image). Set the “Output raster 
size units” to Georeferenced units (indicating me-
ters, in this map), and set both the cell width and 
cell height to 30. For output extent, click … and 
then “Use layer extent”, and select “Roads_2014” 
as layer the layer extent (click OK). Next, click on 
“Advanced parameters”, and set the Output data 
type as “byte” (binary values). Finally, under “Ras-
terized”, click the … icon and “Save to file”, save 
the file as streets_buffer.tif.

You have now successfully prepared this threat map for input to InVEST to perform habitat quality modeling. In 
a real setting, the next step would be to repeat this process for the land-use map, by generating additional buffers 
around land-use types that pose threats to biodiversity (e.g. built-up areas). The procedure is the same. Inside the 
Habitat Quality modeling folder, you can find shape files for agriculture and urban areas for 2015. You can repeat the 
same procedure as mentioned above. All output files should be saved in the threat folder. Here, we will skip this for 
the sake of brevity, and move on to the procedures for using these input datasets in InVEST.

f
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Set the “Workspace”

The next step is define the workplace, i.e. the folder containing all of the raster map input files. Please note all of the 
new files you generate using InVEST will also be saved here. To save time, we have prepared all of the necessary data 
in the “HQA_data/ InVEST HQ Modeling” folder, so please set it as the workspace.

h

From the InVEST HQ Modeling  folder, select the Current Land Cover map (2015LU.tif) and Future Land Cov-
er map (2025LU.tif). 

Optionally, if you have a base map (such as an old map), you can use it as reference by setting it as the Baseline Land 
Cover. Otherwise, please leave it blank. Remember, all of the land-use maps need to be of same spatial resolution and 
should have the same categories of land use classes. 

i

Select the folder containing all of the threat maps (“Threat rasters”). 

InVEST will automatically find each one in the threat maps in the user-specified Folder, based on names in the 
Threats data table. Please set this folder as the “HQA_data/ InVEST HQ Modeling/Threat Rasters” folder. As men-
tioned earlier, threat rasters are maps with values ranging from 0 to 1, with values of 0 meaning that a particular 
pixel has no influence on habitat quality (i.e. pixels farther than 100 meters from a street, given the threat map gen-
erated in Steps 5-6), whereas values of 1 means the pixel has a high threat (i.e. pixels within 100 meters of a street, 
given the map generated in Steps 5-6). Logically speaking, if we construct a road, the threat value should gradually 
fade as we go further from it. Here, we have included three threat rasters: one based on the distance to roads (within 
100 meters = high threat), another based on distance to built-up or urban areas (within 200 meters = high threat), and 
another based on distance to agricultural areas (within 200 meters = high threat).

j

Streets shapefile (left), 100 meter buffer around streets (middle), and final threat raster map (right)

Land-use shapefile with built-up areas extracted (left), 200-meter buffer around built-up areas (middle), and final 
threat raster map (right)

Land-use shapefile with agricultural areas extracted (left), 200 meter buffer around built-up areas (middle), and final 
threat raster map (right)
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After couple of iterations, your model finally completes.  The 
following window will appear if it is completed successfully. 

Click “Run”! 

You will see the following window if all your model parameters are readable by the computer. If not, an error mes-
sage with suggested changes will appear.

m

In the threat data column, you need to put a .csv file (threat.csv) with decay functions and weights of threat classes. 
Please navigate to the HQA_data/ InVEST HQ Modeling folder and select Threats.csv for this parameter. Decay func-
tions can be exponential or linear. You can use a 
consultative process of experts to determine the 
maximum distance where the impact of roads, 
urban area and agriculture area are applicable. For 
instance, urban areas have more impact (weight) 
on habitat degradation compared to roads. There-
after, you can use decay functions either exponen-
tial or linear, as deemed suitable. This means that 
the influence fades out linearly or exponentially. 

Set distance decay functions and weights for each threatk

Please note that in practice, these Excel files need to be prepared using literature survey and/or consultative work-
shops. For instance, you can use Simpson and Sharon diversity indices as proxies to create the sensitivity values 
for each land use classes. For this, you can use any recent biodiversity survey reports or conduct the survey as your 
own. In the sensitivity file, we need to identify the 
habitat class (whether the specific LU class is a 
habitat or not, identified by 1 and 0), then, provide 
relative influence (in a scale of 0 to 1, where 1 is 
highest inference) of each land use class on the 
others. For example, forest (which is a habitat in 
this case), is heavily influenced by urbanization 
and moderately influenced by agriculture. You can 
put relative scoring based on expert judgment or 
your own demarcation criteria. The excel file, as 
shown below, needs to be saved as .csv file. Also, 
as shown below, please see the naming require-
ments. 

In the sensitivity column, please add the sensitivity.csv file. l

Set the “Half-constant” parameter to 0.5. 
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Open the output maps using QGIS

Navigate to the specified workspace folder. You will see an output folder within your working folder. You will find a 
series of processed maps inside it. There are two types of maps, which will give you the desired information on (1) 
current and future habitat quality (quality_c.tif and quality_f.tif) (2) current and future degradation potential (deg_
sum_c.tif and deg_sum_f.tif). You can display these file in QGIS by clicking on the “Layer” menu, highlighting “Add 
Layer” and clicking on “Add Raster layer”. 

The Habitat Quality map shows the relative level of habitat degradation based on the current and future landscape 
(i.e. the land-use that exists, the spatial pattern of the land-use, and the threats present). Higher values indicate bet-
ter habitat quality as well as the distribution of habitat quality across the rest of the landscape. This quality score is 
unitless and does not refer to any particular biodiversity measure. For degradation potential, a high score in a grid 
cell means habitat degradation in the cell is high relative to other cells. These cells are susceptible to the loss of 
biodiversity. You can use different colors and examine the output closely. This is your final modelling product and 
allows you to compare the habitat quality for both the current and future. Here, we show these final outputs for the 
current (2015) land-use below.

n

Congratulations, you’ve learned the basics of habitat quality mapping using InVEST software! 
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Chapter 7: Identifying and im-
plementing countermeasures 
to reduce land-use and climate 
change risks

Damasa B. Magcale-Macandog
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Brian A. Johnson

As discussed in the previous chapters, land-use changes can exacerbate the im-
pacts of climate change, e.g. by causing increased soil erosion and more rapid rain-
fall run-off when vegetated areas are converted to impervious/built-up urban areas. 
The participatory watershed land-use management (PWLM) approach presented in 
this guidebook provides a framework to assess these impacts, and aids in designing 
appropriate climate change adaptation measures with local governments and other 
relevant stakeholders. Previous chapters have focused on the scenario development 
and impact assessment steps of PWLM. The focus of this chapter is to provide some 
guidance for adaptation measure development and implementation, utilizing the 
results of the different impact assessments. It is based mainly on lessons learned 
from our case study in the Santa Rosa watershed in the Philippines.

Overview of this chapter

In this chapter, you will learn:

How to identify countermeasures through a participatory process; 

About potential technologies and funding sources for climate change adaptation; 

About mechanisms for enhancing collaboration between local governments for better 
watershed-level planning, e.g. through the establishment of watershed management 
councils and payment for ecosystem service (PES) schemes.
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Main concepts

Science-based climate actions can be aided by the use a 
framework that involves several key elements including: 
identifying potential future climate change scenarios; 
assessing the impacts of the predicted changes; devel-
oping, appraising, and prioritizing management options 
(e.g., policies, measures); mainstreaming the options into 
development planning; implementing the options; and 
monitoring and evaluating the progress and results of the 
implementation (Endo et al., 2017). The PWLM approach 
presented in this guidebook incorporates these elements 
in its four steps. The first two steps of PWLM (Scenario De-

velopment, and Impact Assessment) represent the (mostly) 
technical aspects of this framework, while the third and 
fourth steps (Countermeasure Development, and Climate 
Resilient Land-use Planning and Implementation) repre-
sent the policy aspects. In this chapter, we demonstrate 
how these third and fourth steps of the PWLM approach 
can be implemented through a case study of the Santa 
Rosa Watershed of the Philippines. This case study is pre-
sented here because the local governments made several 
remarkable achievements, including:

Countermeasures to reduce land-use change and climate 
change impacts are, by their nature, site specific, so the 
measures presented here should be taken as some good 
examples rather than “best practices”. What is important 
is that the countermeasures identified contribute to: en-
hanced collaboration between municipalities, better land-

use planning and management at the watershed scale (e.g. 
to reduce land-use change/climate change impacts on all 
communities in the watershed), and capacity building to 
enable government staff to make better decisions related 
to climate change/land-use change, among other things.

Identifying land-use change/climate change countermeasures at a watershed scale;

Incorporating these measures in their land-use plans; 

Completing training courses on the use of several impact assessment models/software.

Developing a watershed management council to better manage land-use and climate 
change impacts at the watershed scale; and

Case Study of Santa Rosa Watershed

The Santa Rosa watershed is a watershed at risk of im-
mense degradation; In the past two decades it has under-
gone massive land-use changes brought about by rapid 
urbanization and industrialization (Lasco & Espaldon, 
2005; Magcale-Macandog et al., 2011), and further land-use 
changes are expected in the near future. The watershed 
consists of four local government units: Silang (upstream), 
and Santa Rosa City, Biñan, and Cabuyao (downstream). 
These municipalities have experienced a boom in indus-
trial zones, commercial establishments, and high-to-me-
dium end residential developments because of their 
proximity and good transport links to Metro Manila and 
Southern Luzon. The watershed plays an important role 
in the entire region of Calabarzon, one of the most popu-
lated regions in the Philippines, because it drains into the 
Laguna de Bay Lake. The lake is important source of water 
and livelihood for the communities. It is also important 

for various economic sectors, serving diverse functions 
for the fishery sector, providing irrigation water for agri-
cultural sector, serving as transport route for lakeshore 
dwellers and some other products, generating energy for 
hydroelectric power and other industrial uses. But the 
rapid growth in commerce and population is a potential 
threat to water resources due to loss of recharge areas 
and wetlands (WWF, 2009), reducing natural capacity of 
the subwatershed to retain water and hold rainfall during 
rainy days. It has already resulted in widespread flooding 
due to excessive runoff from upland areas or from rising 
lake levels, which were triggered by Typhoon Ondoy in 
2009 (Tongson, 2012). Other environmental problems from 
unsustainable growth in Santa Rosa include water scar-
city in urban areas and water pollution in the lake. Ulti-
mately, flooding, water scarcity and pollution affect the 
households and livelihoods of the communities. 

Introduction
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In the Santa Rosa watershed, countermeasures to reduce 
future land-use change/climate change impacts were 
identified through consultation meetings with local 
officials from the City/Municipal Planning Office, City/
Municipal Environmental Office and City/Municipal 
Engineering Office of the local government units (LGUs) 
located within the watershed. The participants from each 
LGU were grouped together in one table. The results of 
the scenario and impact assessments (covered in Chap-
ters 4-6) were presented in the form of maps and charts.  
The scenarios shown were the current land-use (derived 
from recent satellite images) and the future land use (for 
the period ~2025-2030) based on a participatory mapping 
done in Step 1 of the PWLM approach (Chapter 2). 

Using this information, the LGU officials were asked to 
discuss among themselves to identify the actions that 
can be taken to address these land-use change/climate 
change impacts in their locality. The countermeasures 
could be tailored based on their local physiographic con-
ditions, population distribution, needs, future develop-
ment plans and availability of resources. They were asked 
to write their identified countermeasures on notecards, 
and when completed, all of the notecards were collected 
and displayed at the front of the meeting room.  A repre-

sentative from each LGU then presented and explained 
the identified countermeasures to the whole group (Figure 
7.1.). In this way, the countermeasures could be shared 
among all LGUs in the watershed. Finally, there was a 
question and answer/discussion section to identify and 
summarize the priority/common countermeasures at the 
watershed scale. 

Having considered the impact of future development and 
climate change in terms of flooding and water quality, 
the LGUs devised three categories of priority measures to 
reduce the negative impact of these changes: Zoning en-
hancement measures, river rehabilitation measures, and 
capacity development measures (Table 7.1). 

Firstly, improving zoning ordinances aimed to ease and/
or evade flood risks by, for example, regulating develop-
ment and relocating informal settlers in highly flood-
prone areas. Runoff mitigation measures (including tree 
planting, green roofs/green parking lots) were also sug-
gested to be mandated when forest or agricultural land 
is converted for other purposes, so-as to reduce flood im-
pacts and mitigate water quality degradation (e.g. due to 
increased erosion or runoff of pollutants). 

Participatory countermeasure identification

Priority countermeasures

Figure 7.1. Consultation meeting with LGU officials and iden-
tification of countermeasures to reduce the negative impacts 
of land-use change/climate change.
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In regards to river rehabilitation, a number of ecosys-
tem-based and structural countermeasures were iden-
tified as priority countermeasures.  Foremost of these 
countermeasures was river rehabilitation through dredg-
ing, river clean-up, and slope protection of river banks. 
The Santa Rosa river is the major drainage system in 
the watershed. Figure 7.2 shows that it contains many 
narrow streams and tributaries (<10 meters width) in the 
upstream areas that feed into the main river that culmi-
nates at a dam (Macabling dam).  Beyond the dam are nar-
row (Figure 7.2) and shallow (Figure 7.3) irrigation canals 
and drainage canal systems that supply irrigation water 
to rice fields in the downstream area since the Spanish 
colonial era.  These canal systems are not designed for 
urban drainage, and easily overflow during heavy rains/

typhoons, resulting in frequent flooding in the city.  Solid 
wastes dumped in the riverine channels tend to clog the 
narrow drainage channels, which further exacerbates the 
risk of flooding. Thus, regular river and drainage clean-
up was decided as necessary to allow the free flow of rain 
water and run-off water to minimize occurrence of flood-
ing in the city.  River dredging was another countermea-
sure to increase the river depth in the downstream area 
and thus increase the carrying capacity of the riverine 
system.  The riverbanks in the upstream and midstream 
areas of the river system are prone to riverbank erosion, 
particularly during the typhoon season (Figure 7.4).  Thus 
slope protection of river banks through reforestation of 
upstream areas and riparian areas will minimize the risk 
of river bank erosion.

Description

To avoid and alleviate climate 
impact, and to sequester carbon 
dioxide

To build and strengthen the ability 
of local government to design and 
implement climate actions

Measure

Zoning enhancement

Capacity development

Land-use / land-cover

When forest or agricultural land is converted to 
built-up areas, mandate runoff mitigation 
measures such as tree planting, green parking 
design, water-permeable paving, and vegetated 
roofs. 

Take actions for the strict enforcement of zoning 
ordinances. 

Harmonize land-use among the local governments 
to make the river basin more resilient to 
climate-related disasters.

Develop survey/assessment instrument to 
determine the needs for training and public 
awareness activities; Conduct the NA.

Protection and improvement of environment 
through replanting of endemic and indigenous 
plant species

Proper zoning and land use planning

Rehabilitation of easement and riverbanks

Slope protection along riverbanks

Control encroachment of settlements in easement 
areas

Dredging of sediments

Solid and liquid waste management

Planting of endemic and indigenous plant species

Improvement of drainage

Organize trainings and events to increase 
awareness and preparedness.

Action

Enforce development controls and 
strengthen building codes (e.g. 
elevated flooring) in areas highly 
susceptible to flooding

Construction of floodwalls. 

Devise relocation plan for informal 
settlers in flood-prone areas.

To increase water retaining 
capacity and reduce erosion (e.g., 
reforestation, river cleanup, 
dredging, and riverbank 
reinforcement)

River rehabilitation Regular river cleanupAll areas

Needs assessments (NA) on CCA, 
CCM , disaster preparedness and 
management

Upstream area

Midstream area

Downstream area

Develop campaign materials and training modules 
for CCA, CCM, disaster preparedness and 
management.

Development of campaign materials 
and training modules for CCA, CCM , 
disaster preparedness and 
management

Conduct of trainings and events

Table 7.1. Priority measures to reduce the negative impacts of land-use change/climate change on flooding and water quality.
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Figure 7.2.  Santa Rosa river width. (Source: Zafaralla et al., 
2012)

Figure 7.3. Silang-Sta. Rosa river depth. (Source: Zafaralla et 
al., 2012)

Lastly, the LGUs proposed that training activities should be implemented to strengthen the capacity of local government 
staff. This includes the assessment of training needs and the development of training materials. Along these lines, a se-
ries of training workshops were organized in 2019-2020 (photos shown in Figure 7.5.) to build the capacities of the LGU 
staff to conduct their own land-use change and climate change impact assessments using the free models/software pre-
sented in Chapters 3-65 of this guidebook (QGIS, WEAP, InVEST). Participants who completed these trainings were given 
certificates, and technical support was provided to help the LGU staff utilize these tools for their planning processes.

Figure 7.4.  (a) Depth of flooding and debris, and (b) eroded river banks of Sta. Rosa-Sil-
ang River.  (Source: Zafaralla et al., 2012)

Figure 7.5. Training workshop for LGU staff on impact assessment models/software 
(right) and water quality analysis methods/tools (right).
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As part of the identification of countemeasures, immedi-
ate actions were also proposed according to the needs of 
each local government (Table 7.2). To avoid and alleviate 
flood risks, it was suggested that the building codes in 
high-risk areas in the downstream area (Santa Rosa City) 
be strengthened and that Land Developer’s guidelines 
be prepared in the upstream municipality (Silang) to im-
plement runoff mitigation measures where forest and/or 

agricultural land is converted. Watercourse management 
projects in the downstream basin were also recommend-
ed to maintain and improve watershed protection func-
tion (i.e., flood alleviation, water retention ability) of eco-
system. Additionally, the activities for operationalizing an 
integrated watershed management council (IWMC), called 
the Santa Rosa Watershed Management Council, were 
proposed.  

Proposed projects for implementing the identified measures

Objective

Operationalize 
IWMC

Enhance 
watershed 
protection 
function

Strengthen 
building codes in 
high-risk areas to 
protect people and 
assets 

Promote 
sustainable land 
development and 
conversion 

Project

Operationalize 
Integrated Watershed 
Management Council 
(IWMC) 

Watercourse 
management

Local building codes

Land developers 
guidelines

Expected output

Rules of procedure/ institutional 
arrangement established

Initial activities designed/ 
initiated

Water retention ability of river 
system maintained/ improved

Local building codes devised 
and implemented

Developers guidelines devised 
and implemented

Proponent

Laguna Lake Development 
Authority

Biñan,
Cabuyao,
Santa Rosa LGUs

Santa Rosa LGU

Silang, in cooperation with 
Santa Rosa LGU

Activity

Council meetings

Rules of procedure

Action plan

Joint activities

Monitoring / supervision

Riverbank reinforcement

Dredging

River cleaning

Afforestation & reforestation

Draft local ordinances to 
mandate runoff mitigation 
measures 

Administer legislative actions 
to request for approval 

Monitor/ supervise compliance

Draft administrative guidelines 
for the private sector to 
implement runoff mitigation 
measures 

Organize IEC to familiarize 
stakeholders of proposed 
guidelines 

Monitor/ supervise compliance

Table 7.2: List of proposed projects.
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The next step after identifying these actions/projects is to 
look for potential funding agencies to support and finance 
these projects. Two possible external funding sources 
were identified for this financing: one national fund called 
the People Survival Fund (PSF), and one international 
fund called the Green Climate Fund (GCF). The PSF is spe-
cial fund in the Philippine National Treasury that financ-
es climate change adaptation programs and projects. GCF, 
on the other hand, is a dedicated fund set up by the United 
Nations Framework on Climate Change (UNFCCC) in 2010 
to help developing countries reduce their GHG emissions 
and enhance their ability to respond to climate change.

A series of planning workshops with the LGU officials 
of the Sta. Rosa-Silang subwatershed was conducted to 
brainstorm and plan for the development of a proposal 
for PSF. The outline of the People’s Survival Fund (PSF) 
proposal was designed in one of the planning workshops. 
The projects that were included in the PSF proposal were 
the identified action projects presented in Table 7.2.  A 
Technical Working Group was established to discuss the 
PSF proposal. Parallel to these planning workshops with 
LGUs is the conduct of consultation meetings with the La-
guna Lake Development Authority (LLDA) and the Climate 
Change Commission.  The objectives of the meetings with 
LLDA were to present and discuss the framework of the 
proposal for PSF as well as to seek support and involve-
ment of LLDA in the project implementation.  One of the 
major concerns in the packaging of the proposal is the 
submission of the proposal by multiple LGUs and LLDA.  
At one point, the idea of LLDA as the lead implementing 
agency of the project was explored. The development of 
the PSF proposal underwent several drafts and improve-
ment by the researchers (IGES-UPLB team), LGUs and 
LLDA. Consultation meetings were also done with the 
Climate Change Commission to gather more information 
about the funding scheme, requirements for the proposal 
submission and to explore the possibility of submitting 
a proposal by multiple cities. A draft of the PSF proposal 
was shared with CCC for initial comments. 

Development of GCF project proposal based on this proj-
ect is under consideration and still early stage. CCC is the 
National Designated Authority to endorse all proposals 
for GCF. CCC looks at the quality of the proposal before 
endorsing to GCF. Land Bank is the national accredited 
entity implementing GCF projects. One SAP (Simplified 

Approval Process) project, “Multi-Hazard Impact-Based 
Forecasting and Early Warning System for the Philip-
pines” has been approved by GCF secretariat in Novem-
ber 2019 in Philippines. The project will strengthen the 
Philippines’ ability to adjust to climate impacts, and im-
plement long-term climate risk reduction and adaptation 
measures. It will build on best practice in multi-hazard 
early warning systems and link with forecast-based ac-
tion to maximize impacts on the ground. This includes 
climate-resilient development planning and investment 
(GCF website: https://www.greenclimate.fund/project/
sap010). Further information on GCF proposal develop-
ment and the process can be obtained from GCF official 
website (https://www.greenclimate.fund/)

Aside from external funds for projects, green bonds are 
another important future opportunity of fund raising 
from private sector and local government. Green Bonds 
are defined as “Bonds issued in order to raise finance for 
climate change solutions and labelled as green by the 
issuer. They can be issued by governments, banks, mu-
nicipalities or corporations and can be applied to any debt 
format” (Climate Bond Initiative 2018). Green Bonds have 
been rapidly spreading in the world. The amount of global 
Green Bond issuance was USD3.1 billion in 2012; however, 
in 2018, issuance grew to USD167.3 billion (Ministry of 
the Environment based on data on the CBI website). The 
Securities and Exchange Commission (SEC), Philippines 
has approved on 16 August 2018, the “Guidelines on the 
Issuance of Green Bonds under the ASEAN Green Bonds 
Standards.” These Guidelines set out to adopt the ASEAN 
Green Bond Standards and provide for the rules and pro-
cedures for the issuance of ASEAN Green Bonds in the 
Philippines. The eligible Green Project categories includes 
but are not limited to 1) Renewable energy, 2) Energy effi-
ciency, 3) Pollution prevention and control 4) Environmen-
tally sustainable management of living natural resources 
and land use , 5) Terrestrial and aquatic biodiversity con-
servation, 6) Clean transportation 7) Sustainable water 
and wastewater management, 8) Climate change adap-
tation, 9) Eco-efficient and/or circular economy adapted 
products, 10) production technologies and processes and 
11) Green buildings. These categories all can involve/cover 
the adaptation options identified in this Chapter. Further 
information on the trend of Green Bond can be obtained 
from following websites:

Identifying funding opportunities for proposed projects

International Capital Market Association: 
https://www.icmagroup.org/green-social-and-sustainability-bonds/green-bond-principles-gbp/

Climate Bonds Initiative: https://www.climatebonds.net/

The Green Bond Issuance Promotion Platform: http://greenbondplatform.env.go.jp/en/ 
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Since this project was supported by the Ministry of the 
Environment of Japan, it is possible to introduce adap-
tation technology developed in Japan, another country 
facing climate related disasters in recent years. The 
Japanese government publishes technologies owned by 
private companies on the Climate Change Adaptation 
Platform (A-PLAT: https://adaptation-platform.nies.go.jp/
en/lets/adaptationbiz.html).

In addition, Santa Rosa city previously developed “Land 
Developers Guidebook for the Santa Rosa Watershed” in 
2011 with support from WWF. It introduces several best 
storm water management practices (1. Reducing impervi-
ous surfaces, 2. Low impact development, 3. Water deten-
tion ponds, 4. Grass filter strips, 5. Grassed swales, level 
spreader, 7. Rock-line channel, 8. Check dams, 9. Sediment 
basin, and 10. Sediment trap). Effective use of the results 
and outputs of such past projects is also important.

Potential adaptation technologies

Figure 7.5. Training workshop for LGU staff on impact assessment models/software 
(right) and water quality analysis methods/tools (right).

An Integrated Watershed Management Council for the 
Santa Rosa watershed was formalized by the signing of a 
Memorandum of Agreement (MOA) among the mayors of 
the four LGUs in the watershed and the General Manager 
of the Laguna Lake Development Authority (LLDA) (Figure 
7.7).  This became the very first watershed management 
council established in the entire Laguna Lake basin, and 
aims to harmonize land-use and make collective efforts 
to address weather-related disasters at the watershed 
level. The council members include the LLDA (national 

government agency to provide oversight/coordination) 
and the four LGUs, as well as water utility companies, 
river councils, NGOs, and private companies (including 
Asia Brewery and Malayan University). Since 2017, with 
the election of the IWMC officers led by LLDA, the council 
is conducting quarterly meetings to create and implement 
the integrated watershed management plan. The continu-
ing success of the IWMC lies in the continued commit-
ment and active participation of its members.  

Enhancing collaboration between local governments for watershed-level planning

Figure 7.5. Training workshop for LGU staff on impact assessment models/software 
(right) and water quality analysis methods/tools (right).
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The local governments in the Santa Rosa watershed are 
in the process of revising their Comprehensive Land-
use Plans (CLUPs), following not only the Republic Act 
No. 9729 stipulating that climate change shall be main-
streamed into government policy formulations (Congress 
of the Philippines, 2009), but also the national guidelines 
requiring that local climate change actions shall be main-
streamed into CLUPs (Housing and Land Use Regulatory 
Board, 2013). Upon the approval by the Housing and Land 
Use Regulatory Board and the Sangguniang Panlalawigan 

(i.e. provincial assembly), the CLUPs serve as the basis 
for formulating the local Comprehensive Development 
Plan (CDP) and Local Development Investment Programs 
(LDIP) (Housing and Land Use Regulatory Board, 2013). It is 
essential that the scientific information provided through 
these types of impact assessments be incorporated into 
these local plans. Notably, the City of Santa Rosa revised 
their CLUP based on the climate change countermeasures 
and flood hazard maps produced using the PWLM ap-
proach (Figure 7.8.) (City of Santa Rosa, 2016).

Incorporating countermeasures into land-use plans

Fig. 7.8.  Revised CLUP of Sta Rosa City (2018-2026) and the incorporation of the 
PWLM outputs for countermeasures to climate change.

Finally, payment for ecosystem services (PES) schemes 
were mentioned to be of interest by the LGUs in the Santa 
Rosa watershed. The downstream LGU (Santa Rosa City) 
was particularly interested in providing payments to the 
upstream LGU (Silang) to conserve the natural habitats 
around the river so-as to mitigate flooding and maintain/
improve the river water quality. However, they expressed 

that PES is difficult to implement for many technical and 
non-technical (political and legal) reasons, as well as due 
to lack of experience among the LGUs in regards to PES. 
To support these PES efforts, a series of concept notes on  
“Economic analysis in the Santa Rosa watershed: Scoping 
the possibility for a payments for ecosystem services (PES) 
scheme” was written with the following parts:

Potential for payment for ecosystem services (PES) schemes at the watershed scale

Please see Appendices for these write-ups.

1.  Understanding the Theoretical Framework of a Payments for Ecosystem Services (PES) Scheme

2.  Considerations in designing PES schemes: Targeting Ecosystem Service Buyers and Sellers

3.  Considerations in designing PES schemes: Establishing Ecological Linkages and Valuing Ecosystem Services

4.  Considerations in designing PES schemes: Land Management Options for PES Schemes

5.  Considerations in designing PES schemes: Determining the Price of Ecosystem Services and Funding for PES

6.  Considerations in designing PES schemes: Establishing Payment Mechanisms

7.  Overview of PES Cases in the Philippines
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In this final chapter of the PWLM Guidebook, we have presented a case study to demonstrate how countermeasures, iden-
tified through the PWLM approach, can be identified and then implemented to increase the resilience of coastal commu-
nities in climate hazard-prone regions. We sincerely hope that this guidebook, including the various tutorials included in 
it, can help you to identify the future impacts of climate change and land use change in your own locality, and to develop 
policies and projects to reduce these future risks.
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